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Document Disclaimer

The information in this document has been carefully checked and is believed to be
reliable. However, no responsibility can be assumed for inaccuracies that may not have
been detected. LeCroy reserves the right to revise the information in this document
without notice or penalty.

Changes or Modifications

Any change or modification not expressly approved by LeCroy voids the user’s authority
to operate this equipment.

Trademarks and Servicemarks

CATC, USBAdvisor, USBTracer, USBTrainer, USBMobile, USBMobileHS, and
BusEngine are trademarks of LeCroy.

Microsoft, Windows 98SE, Windows Me, Windows 2000, Windows XP, and Windows NT
are registered trademarks of Microsoft Inc.

All other trademarks are property of their respective companies.

Copyright
Copyright © 2006, LeCroy; All Rights Reserved. This document may be printed and

reproduced without additional permission, but all copies should contain this copyright
notice.

FCC Conformance Statement

This equipment has been tested and found to comply with the limits for a Class A digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference when the equipment is operated in a
commercial environment. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the instruction
manual, may cause harmful interference to radio communications. Operation of this
equipment in a residential area is likely to cause harmful interference in which case the
user is required to correct the interference at his own expense. The end user of this
product should be aware that any changes or modifications made to this equipment
without the approval of LeCroy could result in the product not meeting the Class A limits,
in which case the FCC could void the user's authority to operate the equipment.

EU Conformance Statement

This equipment complies with the EMC Directive 89/336/EEC and the Low Voltage
Directive 73/23/EEC, and their associated amendments for Class A Information
Technology Equipment. It has been tested and found to comply with EN55022:1998
Class A (EN61000-3-2:1998, EN61000-3-3:1995) and EN55024:1998
(EN61000-4-2:1998, EN61000-4-3:1996, EN61000-4-4:1996, EN61000-4-5:1996,
EN61000-4-6:1997, EN61000-4-11:1998), and EN60950:1999. In a domestic
environment this product may cause radio interference in which case the user may be
required to take adequate measures.
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Chapter 1: Overview

The LeCroy USBMobileHS™ USB Hi-Speed Analyzer is a portable, PC Card based, bus
and protocol analyzer that accurately and efficiently debugs, tests and verifies Low, Full,
and Hi-Speed USB semiconductors, devices, software and systems. USBMobileHS
features the CATC Trace software, the de facto standard for recording and analyzing
USB protocol traffic. The CATC Trace simplifies the overall debug process by using
collapsible, color-coded schemes to represent the USB Packet, Transfer and Transaction
layers. Its native On-The-Go (OTG) support automatically detects, decodes, and displays
the HNP and SRP protocols, including VBus pulsing. The USBMobileHS builds upon
LeCroy's experience and knowledge of the needs of the USB development and test
communities. The result is a USB bus and protocol analyzer with unprecedented
functionality, unparalleled flexibility, and uncompromising user friendliness.

Features Benefits

Low power, 16 bit, Type Il  |Personal analyzer. Portable operation with any notebook PC

PC Card Design

CATC Trace software Industry standard speeds up interpretation and debug of USB

display traffic. Compatible with LeCroy USBMobile™, Inspector™,
Chief™,  Advisor™, and USBTracer/Trainer™

OTG (On-The-Go) Record and analyze HNP and SRP including the capturing of

Support VBus pulses

Trace Navigator Define areas of interest and "shrink" the viewable Trace to areas
of most importance

Advanced Triggering Isolate important traffic, specific errors or data patterns

Hardware Filtering Faster analysis by removing non essential fields from the trace

Intelligent Reporting Quickly identify and track error rates, abnormal bus or timing
conditions

Sophisticated Viewing View Packet, Transaction and Transfer layers of the USB protocol

Downloadable trace Share and annotate trace recordings within a development team

viewer software

LeCroy Corporation 1
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1.1 Event Triggering

For efficient development of USB systems, it is critical that users are able to extract
important information from a crowded stream of bus traffic, and accurately identify and
selectively record information that is of most interest. The Events and Action fields for
trigger set-up is intuitive and graphical, thus making pre-recording set-up time efficient.

USBMobileHS provides real-time hardware triggering on the critical components of USB.
Users can custom-configure and control order of events selected for triggering. The count
and sequence options define the rules for data recording sessions. There are two
Counters, Filter Out/In and a Restart option that causes sequencing and counting to start
again. Any sequence can include up to seven events of any type.

Users can adjust the depth of the recording memory - up to 64 megabytes - and
determine where in the recording the trigger is located.

x

Generall oTG I Ewents A

Bu= Cond.
FIDZ{IM]

Dzta Len
FIDA[0UT]

Count [25]

Trigger

Fitter Out

Restart

Save... | Save As Default | Load... |
Cancel |
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1.2 On The Go Support

The USBMobileHS supports OTG (On-The-Go) capabilities. OTG is an emerging
standard in the USB specifications that allows peer-to-peer connectivity among USB
devices and provides a standard USB connection among portable devices. The Analyzer
identifies both the HNP (Host Negotiation Protocol) and SRP (Session Request Protocol)
occurrences, searches for Host A or B, and identifies timing anomalies during HNP and
SRP protocols.

x
General  Misc | Eventsl Actions |
Analpzer Trace Speed —USE On-The-Go
[T On-TheGo SRP

 Low r Dl Fole Devices
* Ful = 2DRDis
" High 0
& Dey Harme:
B
B DewHame
= Sssume B iz 15t Host

Save... | Save As Default | Load... |
Cancel |
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1.3 The CATC Trace

The CATC Trace's ability to extract critical information quickly and intuitively from a
crowded stream of bus traffic is unparalleled. The ability to accurately identify and isolate
very specific packets is vital to speeding debug and development time. Powerful Search
and Find options allow users to quickly get to specific packets, errors and any data type
within a trace file. With filter and hide commands, the CATC Trace removes irrelevant
data from the Trace for efficient viewing.

Lel:ruy UsBMobileHs USE 2.0 All-Speed Protocol Analyzer - [C:'Program Files' LeCroy' UsEMobilel - |E| 1'
File Setup Record Report  Search  Miew  Window  Help Jﬂﬂj
S M EE R @D || BB e Y v [ED @ D owk -

. T -
Pict Trs Trs Xfr B2z Hon Bie bis 55k By 612

Facket i} :’
0 = 2100 ms 3.000ms 00026.7501 5036
Packet
1 = 229.029 ms 000267542 3536
Facket Tim i}
2 = 66467 ms 3.000ms 000271374 5037

Facket
3

Facket
4

Facket Sync S0OF Time Stamp
5 00000001 i) 995917 ps | 00027 4380 5285
Facket Sync S0OF Frame # [CRCS EOP Time Stamp
5 00000001 i) 44 0x0B |250.000ns || 996917 ps | 00027 4388 5375 B
4 ] |
Ready |Recnrd|ng Speed: Full | | |Search: Fiud -
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1.4 Features

General

Fully compliant with USB 2.0 specification

Supports Full-Speed, Low-Speed, and Hi-Speed USB

User friendly "CATC Trace™" Interface that displays bus traffic using color and
graphics

Trace Viewer available as free non-recording, view-only software

Three year warranty and hot-line customer support

Physical Components

Re

PC-Card form factor: Personal analyzer. Low-power, portable operation with any
notebook PC.

Two Mini AB USB ports and cables: Designed to reduce bulk and maintain portabil-
ity and compact size.

64MB of physical recording memory

cording Options

Versatile triggering - bit-wise value and mask data patterns up to sixteen bytes wide
for Setup transactions and data packets.

Triggering on new High-speed PIDs and split transaction special tokens (ERR,
SPLIT, PING, NYET, DATA2, and MDATA).

CATC Trace displays and enumerates High-speed Micro Frames.

Three forms of triggering: Snapshot, Manual and Event.

Transaction sequencer allows triggering on a token qualified by a data pattern and
/or specific handshake or alternately transactions can be filtered (i.e., NAK'd trans-
actions).

Advanced triggering with event counting and sequencing.

Triggering on multiple error conditions - PID bad, bit stuffing bad, CRC bad,
end-of-packet bad, babble, loss of activity, frame length violation, time-out or
turn-around violation, data toggle violation, Token, Bus Conditions, Data Length,
excessive empty frames.

Real-time traffic capture filtering and data packet truncation variable up to 256
bytes.

Adjustable buffer size from 0.4 MB to 64 MB.

LeCroy Corporation
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Display Options
» Utilizes the CATC Trace graphical display of bus packets, transactions, split trans-
actions and transfers.

* Numerous packets and transactions can be grouped under a single transfer while
quickly decoding all essential information.

» Decoding of split transactions up and down stream of a transaction translator is
accomplished with a special hierarchical view.

» Variety of reports provided to summarize key statistics and conditions of interest
with the ability to jump to the selected item in the trace display.

» Flexible input signaling can be recorded with the CATC Trace.

» Trace Viewer is backward compatible with USBTracer™, USBMobile™, Advisor™,
Chief™  Inspector™, and Detective™ trace files.

+ User-friendly trigger position indicated by different colors of pre- and post-trigger
packet color.

* Markers can be set to assist with navigation and time calculations.
+ Hide start-of-frame (SOF) packets as well as any packet or transaction.
+ Search for a specific PID.

+ Detects and alerts the user to every potential bus error, protocol violation, and com-
binations thereof.

» High resolution, accurate time stamping of bus packets, timing measurement and
analysis functions.

» Extensive search and packet hiding capabilities.
+ Comprehensive device class decoding plus user-defined protocol decoding.

Note: Refer to Readme.txt on your installation disks for the latest information on
features.

6 LeCroy Corporation
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Chapter 2: General Description

2.1 USBMobileHS System Components

The LeCroy USBMobileHS 2.0 Hi-Speed Protocol Analyzer package includes the
following items:

*  One LeCroy USBMobileHS Analyzer

* One 1-meter A-B cable (standard A plug to mini B plug)

* One 1-meter A-B cable (mini A plug to mini B plug)

* One 15-centimeter On the Go (OTG) adaptor (standard A receptacle to mini

A plug)
* LeCroy USBMobileHS software program installation CD
*  Product Documentation

2.2 General Description

USBMobileHS™ is controlled through a personal computer PCMCIA slot. It can be used
with portable computers for field service and maintenance as well as with desktop units
in a development environment.

PC for Analysis

-

PCMCILA Card UBE Host

USE Dewnce

USE Under
Analysis

Figure 2.1 USBMobileHS Connection

LeCroy Corporation 7



Chapter 2: General Description USBMobileHS User Manual

USBMobileHS provides on-the-fly detection of and triggering on such events as specific
user-defined bus conditions, packets matching any Packet Identifier (PID), packets
matching a Token or Setup transaction, data patterns, and errors and bus conditions.
Whether recording manually or with a specified Trigger condition, USBMobileHS
continuously records the bus data in a wrap-around fashion until manually stopped or
until the Trigger Event is detected and a specified post-Trigger amount of bus data is
recorded.

Upon detection of a triggering event, the Analyzer continues to record data up to a point
specified by the user. Real-time detection of events can be individually enabled or
disabled to allow triggering on events as they happen. This includes predefined exception
or error conditions and a user-defined set of Trigger events.

The USBMobileHS software provides powerful search functions that enable investigation
of particular bus events and allow the software to identify and highlight specific events.
In addition to immediate analysis, you can print any part of the data. Use the Save As
feature to save the data on disk for later viewing. The program also provides a variety of
timing information and data analysis reports.

2.3 Analyzer PC Requirements

The following is a list of recommended configuration for the host machine that runs the
USBMobileHS application and that is connected to the USBMobileHS Analyzer:

«  Microsoft® Windows® 98SE, Me, 2000, or XP. The USBMobileHS application
can be used on machines with Windows NT 4.0 to view trace files. Microsoft
Internet Explorer, version 5 or newer.

»  For optimum performance, use processors of the Intel Pentium IlI/Pentium 4
family or the AMD Athlon/Duron family, or other compatible processors with
clock speed of 500mHz or higher (Processors of the Intel Pentium II/Celeron
family or AMD K6 family with clock speed of 300mHz or higher are required.)

*  For the best performance, it is recommended to have a minimum of 128 MB
of RAM.

* Atleast 20 MB of free hard disk space is required for the USBMobileHS
installation. Additional disk space is needed for storing the recorded data in
files during the recordings process (can be as much as 50 MB when recording
a full buffer size).

+ Display: Resolution of 1024 x 768 with at least 16-bit color is recommended.
(Resolution of 800 x 600 with 16-bit color is required.)

2.4 USB Specification

Please refer to the Universal Serial Bus Specification, version 2.0 for details on the
protocol. The USB specification is available from the USB Implementers Forum (USB-IF)

at:

USB Implementers Forum Tel: +1/503.296.9892
1730 SW Skyline Blvd. Suite 203 Fax: +1/503.297.1090
Portland, OR 97221 Web: http://www.usb.org/
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2.5 Specifications

Package
Dimensions 5.3x2.1 x0.4 inches
(135 x 54 x 5 millimeters)
Weight 1.8 ounces
(51 grams)
Hardware Interface
Connectors Standard 16-bit Type Il PC Card

Mini A-B Receptacles

Power Consumption
Idle 500 milliamperes (typical)

Active 560 milliamperes (typical)

Environmental Conditions

Operating Range 0 to 55°C (32 to 131°F)
Storage Range -20 to 80°C (-4 to 176°F)
Humidity 10 to 90%, non-condensing

Recording Memory Size
64 MB

Host Compatibility

The instrument works with any PC equipped with a functioning PCMCIA slot and running
the Microsoft® Windows® 98SE, Me, 2000, or XP operating systems.

Product Warranty

LeCroy provides a three-year limited warranty on its products.

LeCroy Corporation
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Chapter 3: Installation

3.1 USB Test Ports

Connect a host to one of the mini A-B receptacles (use an adaptor if necessary), and
connect your device to the other. It does not matter which receptacle you plug into.

£ 1 USBMobile
-  PCMCIA

Host Computer

Note: The USBMobileHS USB 2.0 Classic Analyzer is not a hub device; it connects
to a USB branch by inserting a non-intrusive, high impedance tap. Because
of the poor signal quality in the middle of a USB cable, LeCroy recommends
using the shortest possible cables so that the total length of both cables
together is less than 6 feet. The USB cables provided with your Analyzer

meet this requirement. When longer cables are used, the Analyzer might
record incorrect data.

3.2 Software Installation

Step 1 Insert the USBMobileHS CD-ROM into your computer.
Step 2 Click Install Software when the Auto-Run program is displayed.
Step 3 Follow the installation instructions on your screen.

The Install Wizard automatically installs the necessary files to the computer’s hard drive.
The software is installed in the C:\Program Files\LeCroy\USBMobileHS directory
unless you specify otherwise. Follow the installation instructions on your screen.

LeCroy Corporation
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3.3 Hardware Installation

USBMobileHS components and software are easily installed and quickly ready to run on
most personal computer systems. You can begin USB recordings after following these
initial steps.

Step 1 Insert the CD-ROM.
Step 2 Click NEXT when you see the Add New Hardware Wizard window.
Step 3 Follow the on-screen Plug and Play instructions.

Step 4 Click Finish when you see the message that says "Windows has finished
installing the software that your new hardware requires" and the file
USBMobileHS.inf has been installed on your host PC.

Step 5 Run the program Setup and follow the on-screen instructions.

Launch the LeCroy USBMobileHS program from the LeCroy programs group.
The main software screen opens:

LeCroy USBMobileHS USB 2.0 All-Speed Protocol Analyzer o m]

“ File Setup Record Miew Help ‘

EEEREEEEEETET e L

" [ L] L) - == H H == -
bt Tes Frs X B Hep Bin i £ I 02

Ready |Rec0rding Speed: Full |§ y:

Step 6 From the Help menu, select About USBMobileHS.
If the information below is present, you can record a trace:
USBMobileHS Software Version
+ USBMobileHS Driver Version
* BusEngine™ Version
*  Unit Serial Number

12
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3.4 Your First USB Recording

After installing and launching the software, test USBMobileHS by performing the

following steps:

Step 1 Connect a USB cable to each of the two connectors on the USBMobileHS
module, and then connect the other ends to the USB device under test and USB host

system.

Step 2 Select Recording Options under Setup on the Menu Bar.

Step 3 Select the General tab to display the default settings such as “Snapshot” and
1 Mbyte buffer size. For the first recording, leave the settings unchanged.

Recording Options

General |Misc I Eventsl ﬁl‘-.ctinnsl

— Recording type
¥ Shapshat

£ Manual Trigger

" Ewent Trigger

Optionz

[™ Tiuncate Data Fields B_I,ltes:l 1
[ Beep'When Trigger Dcours

— Butfer Size
0.500 MB

._J—

r— Trigger Position
Mot uzed with snapshot

._J_

— Options M ame

IDefauIt

Change Default Location. . |

"Trace Filename & Path

]

Save.. |

Save Az Default | Load.. |

Canicel |

Step 4 Click OK to activate the recording options you selected.

Step 5 Turn on the USB devices that are to be tested and cause them to generate USB

traffic.

Step 6 Click HEEl on the Tool Bar.

USBMobileHS starts to record the USB traffic immediately. After 1 MB of traffic
has been recorded, the Analyzer uploads the data and displays the packets in

the trace window.

LeCroy Corporation
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Step 7 To terminate the recording before the snapshot automatically

completes, click _I on the Tool Bar.

When the recording session is finished, the traffic is uploaded from the Analyzer
to the hard drive on your PC as a file named data.usb or whatever name you
assigned as the default filename. While the file is being uploaded, you should see
a brown progress bar at the bottom of the screen. When the bar disappears, it
indicates that the data has been uploaded to disk.

Step 8 To save a current recording for future reference, select Save As under File on

the Menu Bar.
OR
Click E| on the Toolbar.

The standard Save As screen appears.

Step 9 Give the recording a unique name and save it to the appropriate directory.

Capturing Your First CATC Trace

After a moment, the recording terminates and the results display.

Lel:ruy UsBMobileHs USE 2.0 All-Speed Protocol Analyzer - [C:'Program Files' LeCroy' UsEMobilel - |E| 1'
File Setup Record Report  Search  Miew  Window  Help Jﬂﬂj
E-EI\““”IREE@}?%HHE Iaﬁ!ﬂ&%%?’da

m Trs .frs xfr £
Packet :’
0
Packet
1 --> 229.029 ms 00026.7542 3536
Facket dle Time Stamp
2 --> 66.467 ms 3.000ms 00027 1374 5037
Packet
8 --> 205753 ms 00027.1930 3082
Facket dle Time Stamp
4 > 10535 ms 2700 ps 00027 4296 2997
Packet Syne SOF Frame # [CRCS ECP
5 00000001 OxA5 O¢15 |250.000ns || 996917 ps
Facket Sync S0OF Frame # [CRCS EOP dle
65 00000001 A5 995917 ps B
KN 0|
Ready |Recording Speed: Full | | |Search: Fad -
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Trace View Features

The USBMobileHS packet view display makes extensive use of color and
graphics to fully document the captured traffic.

Packets are shown on separate rows, with their individual fields both labeled

and color coded.

Packets are numbered (sequentially, as recorded), time-stamped (with a
resolution of 16.67 ns), and highlighted to show the transmitted speed
(low-speed or full-speed).

Display formats can be named and saved for later use.

Pop-up Tool Tips annotate packet fields with detailed information about their

contents

Data fields can be collapsed to occupy minimal space in the display (which

can in turn be zoomed in and out to optimize screen utilization).

The display software can operate independent of the hardware and so can function as a
stand-alone Trace Viewer that may be freely distributed.

Each row numerates, labels, and color-codes a USB packet
I Frame # [ERES

EOP

Before Trigger

Packet

00000001

0x0D | 250 ns

396.883 ps 00010.2143 3621

00000001

Frame # [CRCS| EOP

0x0F |233ns

396.900 ps 00010.2151 3619

00000001

ECP

I Frame # [CRCS

010 (233 ns

Time Stamp

350 ns 00010.2159 3607

BETUP

ADDR EXDL [ERES

EOP

183 ns 00010.2159 3802

2737 00000001 0 | 0«08 |233ns
\ Packst F DAY’ Osta [CREIE| EGP
\ 2738 [--= [E]| 00000001 C3 |8 bytes|0#BB29|233ns|(483ns|  00010.2158 3987
i
YPacket ACK EQP

\EEE]

Sm

00000001

0x4B 233ns

|983.200 ys 00010.2159 4510 |

After Trigger

00000001

m Frame # [CRCS | EQOP

OxAS 724 Ox0E [250ns

Idle Time Stamp
333ns 000102167 3596

ann g G EEEE

AP

Time-stamp appendea 1o each packet

Filtered Traffic is displayed as a gray line
Specifies speed packet transmitted

Indicates a marked comment is set

LeCroy Corporation
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Chapter 4: Software Overview

The USBMobileHS™ software is an application that may be used with or without the
Analyzer. When used without an Analyzer, the program functions in a Trace Viewer mode
to view, analyze, and print captured protocol traffic from USBMobileHS Analyzers. The
software also allows you to view trace files created by the LeCroy USB Tracer™,
USBMobile™, Advisor™, Chief™, Detective™, and Inspector™. Opening a file created
with any of these Analyzers displays a screen asking if you want to convert the old file to
the new format under the name convert.usb.

When the program is used with the USBMobileHS Analyzer attached to the computer,
you can monitor and analyze the activity of your USB branch from either of the USB ports
on the front of the Analyzer.

4.1 Starting the USBMobileHS Program

To start the USBMobileHS program:
Step 1 Click Start > Programs > LeCroy > LeCroy USBMobileHS.

LeCroy USBMobileHS USE 2.0 All-Speed Protocol Analyzer - |EI|£|

“ File Setup Record Miew Help ‘

EEEREEEEEEELET B L

L] L L] 1] H. H H H mems mses mees
Pit Trs Trs Xiv Bes Wi bia Bia B Eie BiR

Ready |Recc-rding Speed: Full |§ &
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4.2 Tool Tips

Tool tips provide useful information about fields and buttons.

her @ | = =
EE Skart Fecording (Cerl+R) 'E'-

In some cases, tool tips spell out acronyms used in trace fields. In other cases, tool tips
provide substantial amounts of additional information. To display a tool tip, position the
mouse pointer over an item.

4.3 Menus

The following table describes the menus within the application. Note that some menus
are context-sensitive.

Packets to Text
(Packet View Format)

Packets to .CSV
(Comma Separated
Values for Excel, etc.)
Format)

Packets to Device
Emulation Traffic
Generation Text File
(-utg)

Data

Menu Function
Eile
Open Opens a file.
Close Closes the current file.
Save As Saves all or a range of packets from the current file.
Print Prints part or all of the current traffic data file.
Print Preview Produces an on-screen preview before printing.
Print Setup Sets the options for the current or new printer.
Edit Comment Creates or edits the Trace file comment field.
Export > Saves all or part of a trace to a text file or generator file.

Saves trace as text file in Packet View Format.

Saves trace as a comma-separated-values text file for use
with Microsoft® Excel.

Packets to Host Traffic | Saves trace as script file that can be used by a Generator to
Generator Text File generate a trace.
(.utg)

Exports packets to Device Emulation files. This option does
not export transactions.

Exports Transfer data as text or binary file

Compare Endpoint
Data

Allows you to select two endpoints of different directions with
the same address and verify that the data OUT/IN is identical
to the data IN/OUT from the other endpoint. Used when
running echo-types of tests for data integrity.

Import

Imports data from a .ved file.

Exit

Exits the USBMobileHS program.

18
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Menu Function
Setup
Display Options Provides display options such as color, formats, and filters.
Recording Options Provides setup options for recording, triggering events, and
filtering events.
Record
Start Begins Analyzer recording of USB activity.
Stop Stops Analyzer recording.
Upload Again Allows you to upload a different portion of the captured trace
if the previous upload was only partially uploaded.
Manual Trigger Causes a trigger in a trace. Available only in Manual Trigger
mode.
Report
File Information Displays information about the recording such as the number
of packets and triggering setup.
Error Summary Summarizes the errors throughout the recording. Allows for
fast navigation to packet with errors.
Timing Calculation Calculates timing between two packets and bus utilization.
Traffic Summary Summarizes the numbers and types of errors, packets,
transactions, split transactions, and transfers that occurred in
the open trace.
Bus Utilization Displays graphs of packet length, bus usage, and bus usage
by device.
Search
Go to Trigger Positions the display to show the first packet that follows the
trigger event.
Go to Packet/ Positions the display to the packet/transaction/transfer
Transaction/Transfer. number selected in the Go to Packet/Transaction/Transfer
menu.
Go to Marker » Positions the display to the selected marked packet.
Goto» Positions the display to the selected event, condition, value,
or type.
Eind Allows complex searches on multiple criteria.
Find Next Repeats the previous Find operation.
Search Direction Allows the search direction to be changed from Forward to
Backward or vice versa.
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Menu Function

View
Toolbars Displays list of available toolbars.
Status Bar Switches display of the Status Bar on or off.
Zoom In Increases the size of the displayed elements.
Zoom Qut Decreases the size of the displayed elements.
Wrap Wraps displayed packets within the window.
Hide SOF’s Hides Start of Frames.
Hide NAK’s Hides NAK’ed Transactions.

Hide Devices

Hides packets belonging to specified devices by address and
endpoint.

Hide Chirps

Hide the Chirp-K and Chirp-J Bus conditions. These are
recorded only in USBMobileHS.

Apply Decoding
Scripts

Decoding scripts set the values of the display and recording
options for optimum views of trace information from specific
vendors or classes of data. This menu option allows you to
select the vendor or class of data for the request recipients
and endpoints listed in the Request Recipients and Endpoints
menu. You can keep the settings across recordings.

Packet Level

Displays Packets.

Transaction Level

Displays Transactions.

Split Transaction
Level

Displays Split Transactions.

Transfer Level

Displays Transfers.

HWA Segment Level

Displays Host Wire Adapter Segments

HWA Transfer Level Displays Host Wire Adapter Transfers
DWA Segment Level Displays Device Wire Adapter Segments
DWA Transfer Level Displays Device Wire Adapter Transfers

PTP Transaction
Level

Displays PTP Transactions

PTP Object Level

Displays PTP Objects

PTP Session Level

Displays PTP Sessions

Refresh Decoding

Performs a re-analysis and re-decoding of all of the
transactions in the trace

Window
New Window Switches display of the Tool Bar on or off.
Cascade Displays all open windows in an overlapping arrangement.

Tile Horizontal

Arranges multiple trace windows as a series of strips across
the main display area.

Tile Vertical

Displays all open windows in a side-by-side arrangement.

Arrange Icons

Arranges minimized windows at the bottom of the display.

Windows ...

Displays a list of open windows.

20

LeCroy Corporation




USBMobileHS User Manual Chapter 4: Software Overview

Menu Function
Help
Help. Displays online help. You can also select F1.
Help Topics Displays online help.
Update License Opens a dialog box for updating your LeCroy license.
Display License Displays information related to licensing.
Information
About USBMobileHS Displays version information about USBMobileHS.

4.4 View Options

You can hide, display or reset toolbars by selecting View > Tool bars from the menu bar.

+  Freguently Used

v Generatar

Cuskomize. ..

Resetting the Toolbars

From time to time (such as following a software upgrade), it is possible for the buttons on
the toolbar to not match their intended function. You can reset the toolbar by performing
the following steps:

Step 1 Select View > Toolbars from the menu bar.
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Step 2 Select Customize from the submenu to display the Customize dialog box.

Customize E

Cammands | Toolbars | Meru | Options |

Cateqaries: Commands:
Setup (= Open...
Record Close
Report

Search H savess..
Wiew

wfindaw &4 Fiint...

Hel

Ne;ﬂ teru [&, Print Preview
All Commands Frint Setup.. LI
Description:

Cloze

Step 3 Select the Toolbars tab to display the Toolbars page of the dialog box.

Customize E3

Commands Toolbars |Menu I Dptionsl

Toolbars:

[wii Untitled:- Feset |
[wlAnalysiz

[w|Frequently zed Rezet Al |
[w]|Generataor

[w] bl i ar Mew... |
[w]Standard

[w]iew Level HEMEME., |

Eelete

= Shiowitextatbel:

Close |

Step 4 Click the Reset All button.
The toolbar resets to the factory defaults.
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Tool Bar

IEEIEESEEE Y B EEE R T

| Bt Frs Trs X on Bon B8n B0e Er E B

Y

[E? ® & w gl -

The Tool Bar provides quick and convenient access to the most popular program
functions. Tool tips describe the functionality of each icon and menu item as the mouse
arrow is moved over the icon/item.

E Open file % Hide Chirps

E Save As Assign High Level Decodes
Preview Find

%l Print Find Next

53

Setup Record Options File Information Report

Setup Display Options Error Report

Start Recording Timing and Bus Usage Calculations

Stop Recording Traffic Summary

Manual Trigger Bus Utilization

“ EREe E R E

W CE 18 2 B B B B

Zoom In Open the Navigator bar
Zoom Out Pkt Display Packets

[ L}
Wrap Trs Display Transactions

[T
Hide SOFs Trs Display Split Transactions
Hide NAK’ed transactions xfgl Display Transfers

= Display Host Wire Adapter
Hide Devices e Segments

LeCroy Corporation 23



Chapter 4: Software Overview

USBMobileHS User Manual

4.5 Status Bar

Display PTP Transactions ;'}inﬁ Display Host Wire Adapter Transfers

Display Device Wire Adapter

Display PTP Objects 2 Segments
- Display Device Wire Adapter
Display PTP Sessions me Transfers

The Status Bar is located at the bottom of the main display window. Depending on the
current activity, the bar can be divided into as many as four segments.

Recording Progress
When you begin recording, the left-most segment of the Status Bar displays a Recording
Progress Indicator.

T Tigger? SN [Search: Fud /|
T Trigger?  [FSINNNI [Search: Fud /|
R | Triggered | Ml |Search: Fed . /}El
| |Uploading  |83% done | Search: Fud . ,;‘;l

As recording progresses, the Progress Indicator changes to reflect the recording
progress graphically. In the Progress Indicator, a black vertical line illustrates the location
of the Trigger Position you selected in Recording Options:

Pre-Trigger progress is displayed in the field to the left of the Trigger Position
in the before-Trigger color specified in the Display Options.

When the Trigger Position is reached, the progress indicator wiggles as it
waits for the trigger.

After the trigger occurs, the field to the right of the Trigger Position fills in the
after-Trigger color specified in the Display Options.

When recording is complete, the upper half of the progress indicator fills in
white, indicating the progress of the data upload to the host computer.

You should be aware of two exceptional conditions:

If a Trigger Event occurs during the before-Trigger recording, the
before-Trigger color changes to the after-Trigger color to indicate that not all
the expected data was recorded pre-Trigger.

When you click Stop before or after a Trigger Event, the Progress Bar adjusts
accordingly to begin uploading the most recently recorded data.

The Progress Bar fills with color in proportion to the specified size and actual rate at which
the hardware is writing and reading the recording memory. However, the Progress
Indicator is normalized to fill the space within the Status Bar.

24
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Recording Status

During recording, the current Recording Status is displayed in the next segment. When
you activate the Record function, this segment flashes one of the following messages
(depending on the selected Recording Options):

+  Trigger?
« Triggered!
+ Uploading

After recording stops:
* The flashing message changes to Uploading data—x% done. (x% indicates
the percentage completion of the data uploading process.)

« The traffic data is copied to disk into the default file data.usb (or whatever file
name you have specified in the Recording Options dialog box).

To abort the upload process:

* Press Esc on your keyboard or click D in the Tool Bar. You are asked if
you want to keep or discard the partially uploaded data. While uploading is in
progress, clicking the Stop button again brings up a dialog with four options:

* Full Buffer/Upload Selection: Allows you to decide how much of the
buffer to upload. Use the slide bar to set the range to be uploaded.

» Stop: Ends the upload process and preserves whatever part of the
recording has been uploaded.

+ Continue: Resumes the upload process.
* Flush: Empties the uploaded trace from the current file.
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The Partial Upload button is enabled when you have partially uploaded data. When you
click this button, a dialog box appears that gives you options on what portion of data you
want to upload again.

Select new upload range within the recorded buffer

] 40
From| 09  to| 31 Total upload | 2.2 tB

Ahbart Upload?
Select an option;

Stop . but preserve existing uploaded data

LContitue | az if Abart nat initiated

Flush data and cancel trace completely

ol

When the data is saved, the Recorded Data file appears in the main display window and
the Recording Status window is cleared.

» If the recording resulted from a Trigger Event, the first packet following the
Trigger (or the packet that caused the Trigger) is initially positioned second
from the top of the display.

« If the recording did not result from a Trigger Event, the display begins with the
first packet in the traffic file.

Recording Activity
During recording, the fourth segment from the left of the Status Bar displays Recording
activity as a series of vertical bars.

The more vertical bars that are displayed, the greater the amount of activity being
recorded. If there are no vertical bars, there is no recorded activity.

During uploading, the percent of the completed upload is displayed.

Note: If packets are filtered from the recording or data are truncated, the recording
activity is reduced.

Search Status

The rightmost segment displays the current search direction: Fwd (forward) or Bwd
(backward). Change the search direction from the Search Menu or double-click in the
Search Status segment.

26
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4.6 Navigation Tools

You can zoom in and out, and wrap packets/transactions/transfers to fit within the screen
using the following buttons:

Zoom In

Zoom In increases the size of the displayed elements, allowing fewer (but larger) packet
fields per screen.

. Click E| on the Tool Bar.

Zoom Out

Zoom Out decreases the size of the displayed elements, allowing more (but smaller)
packet fields per screen.

+ Click El on the Tool Bar.

Wrap

Select Wrap to adjust the Trace View so that packets fit onto one line. If a packet is longer
than the size of the window, the horizontal scroll bar can be used to see the hidden part
of the packet.

* Click = on the Tool Bar or select Wrap under View on the Menu Bar.

LeCroy Corporation
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4.7 USBMobileHS Analyzer Keyboard Shortcuts

Several frequently-used operations are bound to keyboard shortcuts.
Table 1: Keyboard Shortcuts

Operation Key Combination
Trace Navigation
Find Next F3
Search Backwards Ctrl+B
Search Forwards Ctrl+F
Jump to First Packet Ctrl+Home
Jump to Last Packet Ctrl+End
Go to Any Error Shift+E
Go to Channel 0 Ctrl+Shift+0
Go to Channel 1 Ctrl+Shift+1
View Packets CTRL-1
View Transactions CTRL-2
View Split Transactions CTRL-3
View Transfers CTRL-4
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PID

Go to ACK Shift+A
Go to DATAO Shift+0
Go to DATA1 Shift+1
Go to DATA2 Shift+2
Go to DATAX Shift+D
Goto IN Shift+l

Go to MDATA Shift+M
Go to NAK Shift+N
Go to NYET Shift+Y
Go to OUT Shift+O
Go to PING Shift+G
Go to PRE/ERR Shift+P
Go to SETUP Shift+S
Go to SOF Shift+F
Go to SPLIT Shift+X
Go to STALL Shift+L

Bus Conditions

Go to Reset Shift+T
Go to Resume Shift+6
Go to SEO Shift+Z
Go to SE1 Shift+7
Go to Keep-Alive Shift+5
Go to Suspend Shift+U
Go to Chirp Shift+C
Go to Full Speed J Shift+J
Go to Full Speed K Shift+K
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OTG
Go to SRP Ctrl+Q
Go to HNP Shift+H
Go to VBus Voltage Change Shift+V
Go to OTG Host A Ctrl+Shift+A
Go to OTG Host B Ctrl+Shift+B
Misc.
Marker Menu Ctrl+M
Open File Ctrl+O
Print Ctrl+P
Record Ctrl+R
Stop Recording Ctrl+T
Open Display Options dialog Ctrl+Shift+D
Open Recording Options dialog Ctrl+Shift+R
Hide SOFs Ctrl+Shift+S
Hide NAKs Ctrl+Shift+N
Hide Chirps Ctrl+Shift+C
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Chapter 5: Reading a Trace

5.1 Trace View Features

The USBMobileHS™ packet view display makes extensive use of color and
graphics to fully document the captured traffic.

Packets are shown on separate rows, with their individual fields both labeled
and color coded.

Packets are numbered (sequentially, as recorded), time-stamped (with a
resolution of 16.67 ns), and highlighted to show the transmitted speed
(low-speed, full-speed or high-speed).

Display formats can be named and saved for later use.

Pop-up Tool Tips detail the contents of packet fields.

Data fields can be collapsed to occupy minimal space in the display and you
can zoom in and out to optimize screen utilization.

The display software can operated independently of the hardware and so can
function as a stand-alone Trace Viewer that may be freely distributed.

High Speed SOFs display Microframes (shown below.)

Facket H s5aF Frame # CRCS Pkt Len
u] s DS 1156.7 [Ox1C 12 124767 ps= 0oooo 4055 2910
Facket H

S5aF Frame # CRCS Pkt Len
s upra 1M56.7 [0x1C 14 124767 ps= 0oooo 4057 29038

Microframes

LeCroy Corporation
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5.2 Set Marker

You can define a unique marker for each packet.

To place a marker on a packet:

Step 1 Left-click Packet # for the packet to mark to display the Packet menu:

Frame # [ERCS

=02 |FF FF FF FF FE

124728 p= 000000002 0000

I Frame # [CRCS

005 |FF FF FF FF FE

124788 p= 000000003 0000

0.7 0=03 |FF FF FF FF FE|[124.788 ps 00000.0004 0000

Time From Marker

Ay =02 |FF FF FF FF FE [|124.722 ps 00000 0005 0000

Farmak 3

Colar 3 i
o 008 |FF FF FF FF FE || 124788 p= Q0000 0006 Qoo

m Hide

Step 2 Select Set Marker to display the Edit Marker Comment window.:

Mark packet # 401; enter optional marker comment:

]9

LCancel |

Step 3 Enter a comment about the packet.

Step 4 Click OK.

A marked packet is indicated by a vertical red bar along the left edge of the

packet # block:
Facket# 3 Sync
398 =H | ooo0oooo

SETUFR
OxB4

ADDR

ERDF | QP
u] Ox15 | 2.60 z
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5.3 Edit or Clear Marker

To clear or edit the comments associated with a packet marker:
Step 1 Left-click Packet # to display the Packet menu:

Frame # [CRCS
FF FF FF FF FE

Show Raw Bits
7 FF FF FF FF FE

Edit marker
I Time From Marker 7 FF FF FF FF FE E

Format
i FF FF FF FF FE

Color -
I Hide E FF FF FF FF FE

Step 2 To edit the Marker Comment, select Edit Marker Comment to display the Edit
Marker Comment window. Edit the comment, then click OK.

Edit marker comment for packet # 398 : E3

IThe hub driver reads the status for the port and continues with the part initialization

Step 3 To clear a Marker, click Clear Marker.

The vertical red Marker bar disappears.
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5.4 View Raw Bits

You can expand a specific packet to view the raw bits in detail.

To view the raw bits:

Step 1 Left-click Packet # to display the Packet menu:

Frame #

CRCS

FF FF FF FF FE

1247

FF FF FF FF FE

Sek marker
Frame #

7 . o oy

Tirme Fram Marker

CRCS

0:03 | FF FF FF FF FE

1247

FF FF FF FF FE

1247
1247

Format 3
Colar 3
Hide

P ache

1247
T

Step 2 Select Show Raw Bits to display the Raw Bits View for that packet:

Raw Bits display for Packet & 0

| SYNE |

Pid |
|0,0,0,00,0,0,11,0,1,040,1,0,1]0,0,1,0,1,0,0,1]1,1,1,0,0,1,0,1]

Frame # | CRCA |

Shiji)
i

4

Packet

< Prev | Mewt -» |

™ Show Stuif Bits

—

Stuff Bit
Frew | [ et |

Zoom

Stuff Bit Error
Frew | et |

4

Done

Along the top of the Raw Bits View is a linear strip of the logical bit values with

corresponding field demarcations. Bit stuffing is displayed in color. Below the logical bit
values is a representation of the D+/D- signaling complete with NRZ encoding. A scroll
bar assists in navigation of larger packets. Two buttons under the label Packet are used
to view previous or next packets. Two buttons under the label Zoom allow you to zoom

in or out on packets.
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5.5 Expanding and Collapsing Data Fields

You can expand a Data field to view it in greater detail or collapse it when you want a
more compact view.

Using the Expand/Collapse Data Field Arrows

Data Fields can be easily expanded or collapsed by clicking the small triangular arrows
on the left side of the data field.

\ [EYE

|E§ 0D 00 00 00 00 04 oo

Double-Clicking to Expand/Collapse Data Fields

Data fields can also be expanded or collapsed by double-clicking anywhere in the data
field.

Expanding or Collapsing All Data Fields

Expand or collapse all data fields by holding down the button for more than a second.

LeCroy Corporation
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Using the Data Field Pop-up Menus

Data fields can expanded or collapsed by clicking in a data field and selecting Expand
Data or Collapse Data from the pop-up menu.

To expand and collapse data using the menu:
Step 1 Left-click Data in the Data packet you want to expand or collapse.
If your Data Trace View is currently expanded, you see the Collapse Data menu:

Data Field

Yiew Data Block.

Collapse Data
N xpand All Data Fields j noooo.

Collapse All Data Fields
E Format 3
Caolar 4
:m Hide
u] 000,336

If your Data Trace View is currently collapsed, you see the Expand Data menu:

Data Field | oo

Wiew Data Black.

k Expand Data h
oo

Expand All Data Fields

Collapse All Data Fields
=T Farmat 4
Color 3
m Hide
a : : m : 000

Step 2 Select the desired Expand Data or Collapse Data menu item.

The Trace View is repositioned with the selected packet(s) adjusted in the format
you have specified.

Expand or Collapse All Data Fields
All data fields can be expanded or collapsed by selecting Expand All Data Fields or
Collapse All Data Fields from the data field pop-up menus.
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5.6 View Data Block

The data field pop-up menu has an option for viewing the raw bits in a data field.

E Expand Data
Expand All Data Fields

Collapse all Data Figlds

C
E Farmat »
FE Color 3
E

Hide
00000.37

To view these bits:
Step 1 Click in the data field to open the Data Field pop-up menu.
Step 2 Select View Data Block to display the Data Block dialog box.

Data Block of Transaction # 1
Offzet:
00000 [0 02 a8 00 01 01 OO BO =y Pt
oooos |32 o9 & Hex
" Decimal
0 ASC
" Binary

— Shaw per one line

IS_ I bptes hd I

[+ Space out

— Bit Order
' M5B
" LSE

D ata Block size is 10 bytes

The View Data Block window has options for displaying the raw bits in different
formats:

* Format: Lets you display data in Hex, Decimal, ASCII or Binary
formats.

* Show Per Line: Lets you control how many bits are displayed per line.

» Bit Order: Most Significant Bit or Least Significant Bit
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5.7 Pop-up Tool-tips

Many trace fields display pop-up tool-tips that provide added details about the field when
the mouse pointer is suspended over them.

=1 * | ADDR ISRRERCRES ( EOF
OxB 2 u] Ox15 [233 ns||183 ns 0oo004. 2833 6330
:|Starts SETUP transaction to a control pipe

5.8 Hide SOF Packets

You can hide Start-of-Frame (SOF) packets that may be uninteresting in a given context
from a Trace View by clicking the Hide SOF Packets button on the Tool Bar:

+ Click wl to hide all SOF packets.
Note: If you have enabled 2-Stage SOF Hiding in the General Display Options,

then the Hide SOF button works in two stages. Click once to hide all SOFs
that begin frames with no USB traffic. Click twice to hide all SOFs.

5.9 Hide NAKs

You can hide NAKs that may be uninteresting in a given context from a Trace View by
clicking the Hide NAKs button on the Tool Bar:

. click 2 t hide all NAK packets.

5.10 Hide Devices

Click the %l button to get a window that allows you to select any address/endpoint
combination to be hidden.

5.11 Hide Chirps

Click the ﬁé button to hide any Chirped-J or Chirped-K packets recorded in a USB
trace.
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5.12 Switch to Transactions View

A Transaction is defined in the USB specification as the delivery of service to an
endpoint. This consists of a token packet, an optional data packet, and an optional
handshake packet. The specific packets that make up the transaction vary based upon
the transaction type.

The program default display mode is Packet View. Before you can view decoded
transactions, you must switch from Packet View to Transactions View.

To select Transactions View:

+  Click I to on the toolbar.
The Trace View screen is re-drawn to display Transactions.

ouT ACK il
0xa7 1 1] 0[8 bytes 0x4B 998717 ps

ouT ENDP ACK
0x87 1 1] 1]8 bytes 0x4B

Packet [F Sync

G946 --= |8 | 00000001 0x17 |233ns|[183 ns 00011.6037 1516

Packet F Sync

5947 --= |8 | 00000001 500 ns 00011.6037 1701 L
FPacket F Svnc

5948 =-- [t=4| | 00000001 00011.6037 2225

ACK

EMDP

1 0 0x4B 999.800 ps
EMDP ACK

1 1] 1[8 bytes 0x48 998800 ps

| arine ISVEEEIEEY ot A Tirna hd
2l
»

Note: This menu selection displays a check next to Show USB transactions when
you have selected it. When you want to switch back to Packet View mode,
right-click anywhere in the trace window and then left-click Show USB
transactions.

LeCroy Corporation
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You can also switch to Transaction View from the Menu Bar:
Step 1 Select Display Options under Setup to display the Display Options General

window:

Display Options

General | Color / Format / Hiding | Level Hiding |

Zoom Level;

¥ Enable Tips ™ Right click cell contest menu
v “wiap ¥ Hierarchy Lines

Time Stamp Position: I.&t the end ﬂ

™ Ewpand Packet Data Fields by default

r Allovs any Togagle value after Bus Reset
(Int and Bulk Endpoints]

™ Ewxpand Script-Based Decoded Info by default

2-ztage SOF Hiding [First click of Hide SOF button
hides only Empty Frame SOF's)

¥ Use new 5Std Regs & Descriptors Scripts

— Trace Viewing Lewvel

[¥ Packet

[ Tranzaction

[ Split Transaction
[ Transfer

[~ Hw' Segment

[ Hwia Transter

[~ D'w Segment

[ D Transter

™ PTP/MTP Trarnsaction
[ PTP/MTF Object
™ PTR/MTP Session

Analysiz Tools

[ Euror Report
[ Timing Calculatar
[~ Traffic Summary

[~ Bus Utilization
[ Mavigatar

—Fants
Fields: |[aral

Data: IEourier New

= B| 1]
= B| 1]

Configuration M ame: |Lel:m_p default

X

Restore Factory Presetz |

Save... | Save Az Default | Load... |
0k I Cancel | Apply |

Step 2 Check Transactions.
Step 3 Click OK.
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5.13 View Decoded Transactions

Once you set Display Options, the Trace View screen is re-drawn to display decoded
transactions in the colors and format you selected.

[ Paset [OUJEI[ Swne ] our ENDF

[ 6996 [-+[E]]| ooooooot [ o7 1 0 |ox17 [233 ns|[123 ns|  00011.6037 1516
[ Pamet [OTJE|[ Sune Data  [EREABI| EOP

[ sear  [-+[E]| ooooooot 0x02 |5 bytes |0x4FBS5|233 ns|[500 ns| 000116037 1701
[ Paset [OTTEI

| s |

Syne |  ACK
00000001 | mdB 2850 ns|[998.000 ps| 000116037 2225
out Rl oats
027 1 0 |[o]s bytes =G 0999500 ps
auT EWOF
027 1 0 |[1]8 bytes =G 0999500 ps
out Rl oats
087 1 0 |[o]8 bytes 0x48

[ Paset [OTJEI[ Swne ] our ENDF

[ sess [+ [8]| ooooooot [ oeeT 1 0 [0x17 [280 ns|[166 ns|  00011.6061 1481
[ Packet ] A Syne | DpaTan

[ eess |-+ [&]| ooooooot | oxc3 |8 bytes [0x1550 (233 ns|[483 ns| 000116061 1666

When you instruct the Analyzer to display USB transactions, the components of each
transaction are collected from the current recording and are grouped and indented below
each decoded transaction. Each row shows a transaction with a unique numeration, a
label, and color-coded decoding of important data.
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Expanded and Collapsed Transactions
You can expand a specific transaction to view its parts, which are grouped and indented
below the transaction.

To expand a transaction:
Step 1 Left-click the transaction number you wish to view.

You see the Expand Transaction menu:

'1k Transaction 1 1|0 bytes [ 9.733 ps
2 1|0 bytes 048 20,545 mz
Expand Al Transactions

JE T R bRequest IREER] wlength
Collapse all Transactions 7 580 ps
Set marker

110 bytes O3B 40,048 ms
IFerfiE: 4IEN T bRequest wialue wlength m
Calar: 3 7450 p=
Hide

110 bytes O3B 9.000 ps

Step 2 Select Expand This Transaction.

Expand This Transaction

The screen displays the selected transaction in expanded format.

Note: The Expand/Collapse transaction feature operates as a toggle: when one
format is active, the other appears as an option on the Expand/Collapse
drop-down menu.

To collapse a transaction, perform the same operation and select Collapse This
Transaction.

Note that you can choose to expand or collapse
*  Only the selected Transaction
OR

» All Transactions.
It is not necessary to use the Expand/Collapse Transactions menu to shift between
expanded and collapsed views of a transaction:

* Double-click in the Transaction number field to toggle back and forth between
collapsed and expanded views.
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5.14 Switch to Split Transaction View

To select Split Transaction View:
Step 1 Click the *frs| button on the toolbar.

The Trace View screen is re-drawn to display Split Transactions.

T Split Trans [L] ENDF ACH,
44 EEEE 3 0 ||1]12 01 00 01 00 00 00 0| Ox4B

You can also switch to Split Transactions View from the Menu Bar:

Step 1 Select Display Options under Setup to display the Display Options General
window:

Step 2 Check Split Transactions.

5.15 Switch to Transfer View

A Transfer is defined in the USB specification as one or more transactions between a
software client and its function. USB transfers can be one of four kinds: Control, Interrupt,
Bulk, and Isochronous. USBMobileHS is capable of displaying all four types.

The default display mode is Packet View. Before you can view decoded transfers, you
must switch from Packet View (or Transaction View) to Transfer View.

To select Transfer View:
Step 1 Click ¥ on the toolbar.

The Trace View screen is re-drawn to display Transfers.

Note: Selecting Show USB transfers adds a check next to this menu item. If you
want to return to Packet View, open the menu and reselect Show USB
transfers. This action removes the check and returns the display to Packet
View.

To switch to Transfer View from the Menu Bar:

Step 1 Select Display Options under Setup to display the Display Options General
window:

Step 2 Check Transfers.
Step 3 Click OK.

LeCroy Corporation
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5.16 View Decoded Transfers

Once you set Display Options, the Trace View screen is re-drawn to display decoded
transfers in the colors and format you selected.

[ Transier [0 RG] ERDF

1 =3

=1 1 _
SETUF | »D0R EREEIIEREE] Pkt Len
16405 200 ns| 000020675 1628
| DATAD
0xC3 |80 06 00 02 00 00 &F 00|0<EBZ6| 16 233ns| 00002.06751708
Facket H ACH
16407 | 0x4B 7167 us| O000Z.0B75 1728
Accr HNEE [ ack ]
1 i 1|64 bytes Ox4B 7.600 ps
~oor EREE|E  Dat=
1 0 0|64 bytes 0x4B 7.500 ps
~0or [EER
1]43 bytes 0x4B8 0.733 us
ENDPl | ACK
] 0x 4B 525.027 s
H Contral  ADDR J[=@eS t-F—.:ENuest wh alue udndex
2 = GET 1 0 GET_DEECRIPTOR | DEVICE type | 0x0000 || DEVICE deseriptor|| 1.224 see
H Contro ADDR == bRequeast i alue windex
3 = GET 1 [i] GET_DESCRIPTOR|STRIMG type, Index 1 | Language ID 00018 362.4

When you instruct the Analyzer to display USB transfers, the components of each
transfer are collected from the current recording and are grouped below each decoded
transfer. Each transfer row shows a transfer with a unique numeration, a label, and
color-coded decoding of important data.

Facket
16496

w I

Expanded and Collapsed Transfers
You can expand a specific transfer to view its parts, which are grouped and indented
below the transfer.

To expand a transfer:
Step 1 Left-click the transfer number you wish to view.
You see the Expand Transfer menu:

Transfer

Expand all Transfers

™ Transfer
E} Collapse pll Transfers
fitan-iet Sek marker
Y
™ Transfer Formak L4
g
Cajor 3

™ Transfer i
’:5 .
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Step 2 Select Expand This USB Transfer.
The screen displays the selected transfer in expanded format.

F Control ADDR m bRequest wifalue windex
5 1

SET_INTERFACE | Mew alternate setting O | Interface # 0

SETUP | ~ceor EXGE(EMIT R bRequest wlength

H-:D | S| | [SET_INTERFACE [ Meuw altarnate seﬂlngD Interface # 0 0 OB

[ I HIEL SETUF  ADDR m CRCS EOF
[ |-+ | oooooood (=R 07 [233 ns|[183 ns|  00011.5050 1536
[ Paset [UlJ@|[Swne | DaTed
| sezs |- [El|| 00000001 | oxC3 |8 bytes|D:231F[233 ns|[483 ns|  000411.5089 1771
[ I A Ewne [ Ack
[ [ = [Ef]] oooooooq [ 0e4B [233 ns|[982.017 ps|  00011.5089 2204
E 1|0 bytes 048 2.000 ms

Bl| [ Centrel | Aror [T IEREGUEE v/ alu- RIS

10 5 SET 0 001 00000 [ 040000 || 64 bytes || 10.992 ms
Bl central | ApDR m BRequest vvalue [indes

11 5 SET 1 001 00000 | 00001 || 64 bytes || 10.995 ms

Note: The Expand/Collapse transfer feature operates as a toggle: when one format
is active, the other appears as an option on the Expand/Collapse drop-down
menu.

Facket
G025

Packet
Goz7

To collapse a transfer, perform the same operation and select Collapse This USB
Transfer.

Note that you can choose to expand or collapse:

*  Only the selected Transfer
OR

e All Transfers.

It is not necessary to use the Expand/Collapse Transfers menu to shift between
expanded and collapsed views of a transfers:

* Double-click in the Transfer number field to toggle back and forth between
collapsed and expanded views.

5.17 Decoding Protocol-Specific Fields in
Transactions and Transfers

When transfers or transactions are displayed, the fields in setup transactions or control,
interrupt, and Bulk transfers by default do not get decoded and are shown in hexadecimal
values. The exceptions are setup transactions and control transfers for standard USB
device requests which are always decoded.

In order to show specific decoding for class- and vendor-specific device requests and
endpoints, you have to use the decoding association mechanism that is described in
Chapter 9 on decoding. When you have performed the association, you see the
protocol-specific fields of transfers and transactions decoded in the trace view.
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5.18 Switch to Host Wire Adapter Segment View

A Host Wire Adapter Segment is one or more transfers between a PC and a host wire
adapter. To view host wire adapter segments, switch to the Host Wire Adapter Segment

trace viewing level.

To select the Host Wire Adapter Segment trace viewing level:

«  Click 5¥# on the toolbar.
OR

+ Select View > Show Host Wire Adapter Segment.
OR

+ Select Setup > Display Options to display the Display Options window,

check HWA Segment, and then click OK.
The program redraws the trace view.

[ Packet [UTEN[ SOF Frwnnpn:ﬁmun Time Stamp
[ 8707 [-= 5] A5 | 12013 | 0x09 500.000n5 | 000133777 5058

Conirol Transter | HyWWA_Addr [RPIpe | Transferld

Transfer \ Bulk
| 27 Sl our

1 TR

[ ourT SRR EnDR]| [T EEEE [ ACK ]

0x87 1 1 |[0]24 bytes|[ 0@B 00013 3777 6146
[ Packet [ 0]a]] ouUT ENDP
[as7i0 | = |5 oe7 1 1 oA 10 166660 ns | 000133777 6148
[ Packet [LJH]] DaTA0 EEEREE FltLHm
[ 148711 |-=[5]] mxC3 |24 bytes|0xd9C0 266670ns | 000133777 5166
[ Packet [RIJE][  ACK
| < [El 0B 12354 ms | 00013 3777 6218

148712

H \r\turm[-t ADDR ENDP [ hotification | 8 Time Stamp
TRANSFER

S 377100 s | 00013.3876 4962

[ Transter | ENDPHTransferResu\t\ Status |
29 |[ TRANSFER [SUCCESS|| 249933 us | 00013.3870 5088
H Buk  ADDR BN
30 12875 ms | 0001338815084
[ Packet [ENTEN[ SOF  |ECmcEale: s FHLHH
| 148713 |-= 18] mas [ 12014 | 08 500.000ns | 00013.3778 5058
n ADDR [ENEE
3 Ox5A 124467 ps_| 000133778 5088
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5.19 Switch to Host Wire Adapter Transfer View

A Host Wire Adapter Transfer is one or more wire adapter segments or one or more
transfers between a PC and a host wire adapter. To view host wire adapter transfers,
switch to the Host Wire Adapter Transfer trace viewing level.

To select the Host Wire Adapter Transfer trace viewing level:

«  Click ¥ on the toolbar.
OR

» Select View > Show Host Wire Adapter Transfer.
OR

+ Select Setup > Display Options to display the Display Options window,
check HWA Transfer, and then click OK.

5.20 Switch to Device Wire Adapter Segment View

A Device Wire Adapter Segment is one or more transfers between a PC and a device
wire adapter. To view device wire adapter segments, switch to the Device Wire Adapter
Segment trace viewing level.

To select the Device Wire Adapter Segment trace viewing level:

«  Click 2# on the toolbar.
OR

+ Select View > Show Device Wire Adapter Segment.
OR

+ Select Setup > Display Options to display the Display Options window,
check DWA Segment, and then click OK.

5.21 Switch to Device Wire Adapter Transfer View

A Device Wire Adapter Transfer is one or more wire adapter segments or one or more
transfers between a PC and a device wire adapter. To view device wire adapter transfers,
switch to the Device Wire Adapter Transfer trace viewing level.

To select the Device Wire Adapter Transfer trace viewing level:

+  Click 3% on the toolbar.
OR

» Select View > Show Device Wire Adapter Transfer.
OR

» Select Setup > Display Options to display the Display Options window,
check DWA Transfer, and then click OK.
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5.22 Switch to PTP Transactions

The Analyzer supports the Picture Transfer Protocol (PTP) and also supports the
Media Transfer Protocol (MTP), which is an extension of PTP. The Analyzer can track
PTP transactions, object transfers, and sessions.

A transaction is a standard sequence of phases for invoking an action. In PTP, an
Initiator-initiated action provides input parameters, responses with parameters, and
binary data exchange, and is a single PTP Transaction. Also, a single Asynchronous
Event sent through the interrupt pipe is a single PTP Transaction.

The PTP Transaction trace viewing level is the lowest PTP level.
To view PTP transactions, switch to the PTP Transaction trace viewing level:

* Click ;T"FTT.!.' on the toolbar.
OR

e Select View > Show PTP Transaction.
OR

+ Select Setup > Display Options to display the Display Options window,
check PTP Transaction, and then click OK.

5.23 Switch to PTP Object Transfers

A logical object on a device has a unique 32-bit identifier (object handle). The

object handle is also unique for the session (defined below). An object transfer contains
all the transactions for an object handle. In PTP, all of an object handle’s

PTP Transactions are a single PTP Object Transfer.

A PTP Object Transfer can include both PTP Transactions that involve an
Initiator-initiated action (for example, GetObject, DeleteObject, and GetObjectinfo
transactions) and PTP Transactions that involve a single Asynchronous Event sent
through the interrupt pipe.

The PTP Object Transfer trace viewing level is the middle PTP level.

To view PTP object transfers, switch to the PTP Object Transfer trace viewing level:

+  Click E&® on the toolbar.
OR

+ Select View > Show PTP Object.
OR

+ Select Setup > Display Options to display the Display Options window,
check PTP Object, and then click OK.
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5.24 Switch to PTP Sessions

A session is a state of persisting communication between a device and a host during

which the connection is continuous and the login and other communication parameters
do not change. A session begins with an OpenSession operation, which establishes the
communications connection and parameters, and ends with a CloseSession operation.

A session contains all object transfers (and their transactions), plus all transactions that
do not belong to object transfers, between an OpenSession operation and a
CloseSession operation. For PTP, all PTP Object Transfers and all PTP Transactions
that occur from the OpenSession operation to the CloseSession operation is a single
PTP Session.

The PTP Session trace viewing level is the highest PTP level.
To view PTP sessions, switch to the PTP Session trace viewing level:

* Click EEE on the toolbar.
OR

« Select View > Show PTP Session.
OR

+ Select Setup > Display Options to display the Display Options window,
check PTP Session, and then click OK.
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5.25 Using the Trace Navigator

You can use the Trace Navigator to show the structure of the
entire trace from different points on the Trace view, thereby
refining the trace view to a packet range in the trace that is most
interesting to you. This range can be set by you to show smaller
parts of the trace.

To display the Navigator bar, click @ in the toolbar or select
the Navigation Bar checkbox in the Display Options General
window.

The Navigator bar can be repositioned in the trace and can be
oriented horizontally or vertically, docked or undocked by
dragging the parallel bars at the top or side of the Navigator bar.
By default, the Navigator bar appears vertically to the right of
the trace window.

The Navigator bar represents different types of trace
information in the order of the packets. The top of each bar
corresponds to the first packet in the trace, and the bottom
corresponds to the last packet. The Navigator bar is made up
of three parts: Pre and Post-Trigger traffic, Errors, and

Types of Traffic.

At any time, a line in the navigator bar of one pixel in height
represents a fraction of the trace data. If the Navigation bar is
400 pixels high, then each bar in this example would represent
1/400 of the trace. If the trace had 4000 packets total, each bar
would represent ten packets. In the Types of Traffic portion of
the navigation bar, the color of the bar would be that of the most
important item in those ten packets. See “Navigator Bar
Attributes” on page 52.

Drag the yellow caret, at the top or bottom, to set the packet
range. When you move the caret, a message shows the packet
range.

The blue caret indicates the current packet position in the trace
view.

Mavigator <
| F) B3

—_

Tvpes of traffic
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Right-click the Navigator to display the pop-up menu.

v Errars

Set Range to Whaole Trace
Set Range near Packet 2492
Recently sed Ranges »

* Pre/Post Trigger, Errors, Types of Traffic: Shows or hides traffic
information in the Navigator.

* Legend: Shows or hides Trigger, Error, and Traffic Type categories in the

Navigator.
Mavigator Legend x|
v Pre/Post Trigger
Il Fre-tigger .
[¥  Post-tigger -
v Enmars

¥

W Types of traffic

I d Transaction
R —
[¥  Start of Frame
Options vl Anply | (1].4 | Cancel |

+ Set Range to Whole Trace: Resets packet range to the entire trace.

+ Set range near packet number: Sets the packet range near the packet
where your mouse pointer is positioned in the Navigator bar.

* Recently Used Ranges: Displays a history of ranges that were previously
selected.
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Navigator Bar Attributes

Mavigator [
Nl <>

Pre/Post Trigger Bar T

+  Brown - Pre-tngger packets
«  Yellow - Post-trigzer packets

PrefPost Trigger
| Twpes of traffic

Errors Bar —

+ Eed - Packet errors in a trace —
Traffic Type Bar

*  Darl red - Eeset

+  Purple - Suspend

«  rey - Stall

« Pk - Control transfers

+  PBrown - Data transactons
+  PBlack - MAK d transactons
«  Light blue - Start of Frame (5OF)

The traffic types are shown in order of importance. For example, if a NAK'd transaction
occurred in the same sample area as a SOF, the NAK would take precedence, and the
Navigator would show the black bar.

5.26 Edit Comment

You can create, view, or edit the 100-character comment field associated with each
Trace file. These comments are visible in the Windows® Explorer if the Comments
attribute is included in the Details view.

Step 1 Select Edit Comment under File on the Menu Bar to display the Edit comment
for trace file window:

Edit comment for trace hle: E

Ifl'his iz a recording of & connection of a hub with a keyboard and M5 [55-80 to anather hub.

Cancel |

Step 2 Create, view, or edit the comment.
Step 3 Click OK.
You can view comments in Windows Explorer by selecting the Comments attribute.
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Chapter 6: Searching Traces

The Search feature provides methods for searching recorded traffic to find specific
packets based on triggering status, packet number, marking, or content.

To view the Search options:

Go ko Trigger
G0 ko PacketTransaction) Transfer. ..
G ko Marker 3

Go ko L

Eind. ..

<<

Fird Mext F3

Search Direction Forward

* Click Search in the Menu bar ti display the Search drop-down menu:

6.1 Go to Trigger

Note: Go to Trigger is enabled only when a trigger has created a traffic file.

To display a Trigger Event:
+ Select Go to Trigger under Search on the Menu Bar.

The Trace View is repositioned to the first packet following the Trigger event. This packet
is at the top of the screen.
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6.2 Go to Packet/Transaction/Transfer

To display a specific packet:

Step 1 From the menu bar, select Search > Go to Packet/Transaction/Transfer to
display the Go to Packet window:

Go to Packet;/Transaction/Transfer ﬂ

Gota: IF'acket ﬂ IE o IPacketﬂD[Trigger] ﬂ

Cancel |

Step 2 Select the desired viewing level (packet, transaction etc.) from the drop-down
menu next to the words Go to.

Step 3 Enter the number of the packet you want to display.
Step 4 Click OK.

The Trace View is repositioned with the selected packet at the top of your screen.

6.3 Go to Marker

To instruct the Analyzer to display a marked packet:

Step 1 Select Go to Marker under Search on the Menu Bar to display a drop-down
menu listing the marked packets in the Trace View:

Search Wiew ‘Window Help

30 ko Trigger

Eod

Go ko Packet/Transaction)Transfer. ..

Go ko Marker Packet # 4 {Marker1)

5o ko r Packet # 15 (Markerz)
% Find. .. all Markers. ..
“¥_ Find Mext F3

Search Direction Forward

o0s7. 1310 5269

Step 2 Select the desired packet from the displayed list. The Trace View is repositioned
with the selected packet at the top of your screen.

Note: The Go to Marker feature functions in conjunction with the Set Marker
feature. The comments within the parentheses following each marked
packet are added or edited with the Set Marker feature. Please refer to Set
Marker in Reading a CATC Trace.

You can use Ctrl+M to go immediately to the All Markers dialog.
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6.4 Go To

The Go To feature takes you directly to an event in a Trace.

Step 1 Select Go To under Search on the Menu Bar to display the Go To drop-down
menu:

Search  Miew

Go ko Trigger

Whfirdio

o ko Packet/Transaction) Transfer, .

G0 to Marker

Go ko

kM »

v End...
S Find et F3
Search Direction Farward

00007 1743 2656

Step 2 Select the event you want to go to and enter the necessary information.

PID
AMY Error
Specific Errors
Data Length
Addr & Endp

Bus Conditions

Shift+E

Split HubAddr & Port

on-The-Go

Channel

3
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Packet IDs (PIDs)

Search  ¥iew  window  Help

o to Trigger

G0 to Packet/ Transaction) Transfer. ..

o to Marker Chrl+1 b
S8 Find, ., ANY Error Shift+E i Shift-+I
%:., i et F3 Specific Errors 4 SOF Shift+F
Data Length 4 SETIP Shift+5
Search Direction Forward
Addr & Endp L4 DAaTAD shift+0
00001 | OxA5 | 1942 | Ox18 Bus Conditions ’ DATAL Shift+1

FENGES Csle:  SpltHubAddr&Fort | DATAZ Shift42
100001 OxAS 1943 | 07 On-The-Go C MDATE Shift-+1

Frame # [CROSNEE0E e ShiFt-+4,

100001 0xAS 1944 | 0x17 [233 na || 997,117 ps | o Sty

STl Shifik+L

100001 A5 1845 | 0x08 (233 ns % MYET: ShiFE
5 FRE[ERR ShifE+P

100001 OxAS 1945 | 0x0A | 250 ns % SELIT Shife
PING Shift+G

100001 IEF 1847 | Ox15 (233 ns % Reseryed () Stift+R

Frame # [CRECS “ DATAX Shift-+D
INAnm NwdA 1048 [ nenR (280 n= 11 Q87 M7 s T PP

Select the type of packet to which you want to go.
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ANY Error
Repositions the trace to show the next instance of any error.

Errors

The Errors menu allows you to search for five different types of error: PID, CRC5,
CRC16, Packet Length, and Stuff Bits. Menu items appear in bold if they are present in
the trace or are grayed out if not present in the trace, as shown in the example below.

Search  ¥iew  window  Help

o to Trigger

G0 to Packet/ Transaction) Transfer. ..

o to Marker Chrl+1 b

eID .m
ShFt4E [ 00001.1236 43582

% Eind AN Errar
See: Find et Fa BID
Data Length » CRCS
Search Direction Forward
Addr & Endp L4 CRC16
00001 | 05 3 008 Bis conditions r Packet Length
iync SOF Split Hubaddr & Port 4 Skuff Bits
1a0an A5 on-The-Go 3 EQP
yne Channel 4 Babble Start I
100001 03596 1 1 O 1A 12580 ns || 333 ns Babble End (LOA) |

ync Frame Length
100001 Ox54 260 ns 5.000 ps 00001 1260 47, TurnaroundiTimeout
yne I ADDR RSN CRES [ats Toadle

100001 0396 1 1 Ox1A | 250 ns 333 ns MicroFrame

e DATA1 5 Data CRC1E Analyzer (Internal)
100001 =02 2 bytes|0x/CF5|250 ns 500 nis Incomplete Last Byke

e ] Ack TN TR

You can press Shift+E to go to the first error of any type.
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Data Length

Allows you to search for data packets of particular lengths. Lengths are displayed in
Bytes in a drop down menu as shown below. Selecting a length causes the display to
move to the next instance of that packet length.

Search iew Window Help

o ko Trigger
o ko PacketTransaction) Transfer. ..

I
i Go ko Marker

CErl4-M »
ET—
% Eind...
| S Find fext Fa

Search Direction Forward

100001 OxA5 3 Ox0A

Specific Errors

Diata Length

aync =0F
100001 OxA5

N
100001

Addr & Endp

Bus Conditions

Split Hub&ddr & Port
On-The-Go

Zhannel

3

3

Ox1A {250 ns ||

333 ns

| e
PID N Time Star]
AMY Error ShifbE a0001.1236 4

1023
1024

Mare. ..

Addr & Endp

The Addr & Endp feature allows you to search for the next packet which contains a

particular address and endpoint. All available address endpoint combinations are

displayed in the pull down menu.

Search Miew Window Help

o ko Trigger

i

Go to PacketTransaction) Transfer. ..

Go ko Marker CErl+r e

S Find...

S Find et F3
Search Direction Forward
100001 OxA5 1942 | Ox18
wne S0F Frame # [CRCS
100001 OxA5 0x07
wne S0F Frame # [CRCS

D *M
ANY Error cfee | 00003.2708 BE7”
00003.27 16 657

Specific Errors 4

Data Length b

Addr & Endp

Bus Conditions k
Split Hub&ddr & Part b
Cn-The-Go »

Channel

0oo 0o
0oz 0o

More, ..

o=/ 5. bR

Time Stamp
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Bus Conditions

Allows you to search by bus conditions such as traffic speed, reset, and suspend. All
available bus conditions are displayed in the pull down menu.

Search  Wiew  Window  Help

50 ko Trigger

Go to PacketfTransactioniTransfer. .,

Go ko Marker ChrlHH b

chiftsg L 0D003.2708 6671

[ % Eind... AMY Error

| Y. Find et o Specific Errars 2
i = Data Length y | 000032716 6673

Search Direction Forward
| - Addr & Endp

Jo0a01 | DxAS | 1942 Dx18 Bus Conditions

EREE:  Split Hubaddr & Port

100001 [AG 1943 | 0507 onThe-go .

Frame # [CRCS

O0x17

Frame # [CRCS

100001 D345 1945 | 0x08 |233 ns 996967 ps

100001 Oy 1946 | Ox0A | 250 ns 997017 ps

Frame # [CRCS

100001 D345 1947 | Ox15 |233 ns 997.050 ps

Frame # [CRES

100001 OxAa 1948 | 0x0B | 250 ns 997 017 ps

Channel 3
[Z33ns [ 997117 ps |

100001

[T

SnFE

Keep glive SHift+5
Reset Shift+T
Suspend Shift-HL
Fesume Shift+&
hirp ShiftE
SEL SHifE+7
SEO SHift+Z
F5 JanHS Shifit1
F5 K on HE Stk
WEUs Yoltage Change SHiFE+,

Low Speed
Full Speed
High Speed
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Split HubAddr & Port

Allows you to search by Hub Address and port. If present, the option
More opens a dialog box with a list of addresses and ports.

Search Miew Window Help
50 ko Trigger % | Y S

o to PacketTransaction) Transfer. ..

o ko Marker CEFH ¢

% Find AR Error shift+E 21D
% Find Mexk F3 Specific Errars
= Data Lenagth
Seatch Direckion Forward
Addr & Endp
(A0 1158607 | 0x1C 12 1

Bus Conditions
Frame # CRCS|[ Pkt Len Split Hubéddr & Port
On-The-Go

Channel

On-the-Go
Allows you to search for On-the-go attributes. The On-the-Go menu contains entries for:
* HNP - Host Negotiation Protocol
» SRP - Session Request Protocol
* Host: A - Hosts with an A plug
* Host: B - Hosts with a B plug

Search Miew Window  Help

1 Go to Trigger

Go to Packet TransactionfTransfer. ..

{
F Go to Marker Chrl+1 ¥

] Y nd. ANY Errar shiftee 053 ps 000017.4105 3582
S Find pext F3 Specific Errors 5 m
| Data Length y 083 ps 000017.4113 3582
! Search Direction Forward addr & Endp N m
}l 00000001 0345 | ] Bus Conditions » 053 ps 000017.4121 3582
Sync S0F F Split HubAddr & Port Time Stamp
3 00000001 OxA5 1 On-The-Go HIF Shift+H  F
E Sync | Channel r SHE Shift-Cr
® 00000001 0xB4 0 [ 0O [0x08 [250ns ||

:E Sync DATAD
. 00000001 0%C3

Huost & Crrl4-Shift+-8

1=

Host : B Chrl+5hift+E

) T TTE.

60 LeCroy Corporation



USBMobileHS User Manual Chapter 6: Searching Traces

Channel
Allows you to search for traffic by 1 (Classic-Speed) or 0 (Hi-Speed).

Search  Wiew Window  Help

Go ko Trigger

Go ko Packet Transaction) Transfer ...

Go ko Marker Chrl+1 e

Gotko PID Starmp

% End ANY Error Shift+E £6 3210
Qﬁ; Fimd et F3 Specific Errors
Data Length
Search Direction Farvard

Addr & Endp

OxAs | 1186.7 [0x1C]| 12 |

Bus Conditions

SOF Frame # |[CRCS E Split HubAddr & Part

OxA5 | 1156.2 |Ox1C| 12 On-The-Go

Frame # |[CRCS Channel
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6.5 Find

Find allows searches to be conducted on an open trace using one or more criteria. You
can search by packet, transactions, split transaction, transfer, by packet type and by
fields within packets.

Find is run by selecting Search > Find or by clicking ﬂ on the toolbar.

Searches can combine criteria using the options Intersection and Union. Intersection
creates AND statements such as "Find all packets with x AND y." Union creates OR
statements such as "Find all packets with x OR y."

You can also perform searches whereby packets or events are excluded from a trace.
The Exclusion allows searches to be conducted.

To perform a search:
Step 1 Select Find ... under Search on the Menu Bar
OR
Click il in the Tool Bar to display the User-Defined Find Events screen:

Search for — Packetz To Search For
— Event Groups
Transzactions Address / Endpoint - - Dir:
Split Transactions l.:I:Ir..... Endpaint Addr. Endp: Dir:
Transfers [1Data Pattem 000 oo
HWA Segments [C1Data Lengths ool o
gﬁg glanslers 15 plit ool o1 M
egments  — ifi ool o2 our
DWA Transfors g:jacketldenhflers o0s N
PTP/MTP Transacx] rames
[ 1Busz Conditionz ;I
r— Dlirection
r(: Farward Uncheck Al
Backward
Al Caombining zpecified
— Drigin Ewent Groups:
‘ol Fth  Union - Packets
Op Ot the screen that match ANY of the zpecified
" Last match . events
" Start of the fils % |ntersection - Packets
| Endlof the file that match ALL of the specified
events
[~ Find &1 ™ Exclusion - Packets

that 00 MOT match [opposite

I Search In Hidden to the intergection or union)

[ o |

Cancel

Step 2 Select Packets, Transactions, Split Transactions, Transfers, HWA
Segments, HWA Transfers, DWA Segments, DWA Transfers,
PTP/MTP Transactions, PTP/MTP Objects, or PTP/MTP Sessions from the
top left list box to list that type of event in the Events Group box.

Step 3 Select one or more events from the Events Group box.
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Step 4 Select one of the following options:

* Union: Find all packets matching ANY of the specified events.

&

» Intersection: Find packets matching ALL of the specified events.

€

+ Exclusion: Exclude packets matching any of the specified events. Exclusion
works with the other two options: Select Union AND Exclusion (=Exclude
packets with ANY of the following fields) or Intersection AND Exclusion
(=Exclude packets with ALL of the following fields.)

Step 5 If desired, set the search Direction and Origin.
Step 6 Click OK.

After the search finishes, the program displays the packets meeting the search criteria.

6.6 Find Next

To apply the previous Find parameters to the next search:

¢ Select Find Next under Search on the Menu Bar
OR

¢ Click le on the Tool Bar.

6.7 Search Direction

Toggles the search forward or backwards. The current direction is indicated in the menu.
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Chapter 7: Display Options

You can select what information to display in CATC Traces using the Display Options
window.

To open the Display Options window:

+ Select Display Options under Setup on the Menu Bar.
OR

« Click E? on the Tool Bar.

Display Options |

General | Color / Format / Hiding | Level Hidina |

Zoorm Level: |l — Trace Viewing Lesel

[V Enable Tips [~ Right click cell context menu I7 Packet _

¥ wiap ¥ Hierarchy Lines r Tra.nsactu:un .
[ Split Transaction

Time Stamp Pozition: I.-’-‘«t the end j W T

™ Expand Packet Data Figlds by default I™ HwA Segment
[~ Hwia Tramsfer

Alloww ary Toggle value after Bus Reszet
B R Er ] I DWwA Segment

[ Expand Sciipt-Based Decoded Info by default I DWA Transfer

PTR/MTP T i
[~ 2stage SOF Hiding (First click of Hide SOF buttan F ETRMTP Dfs_”sac 1an
hides only Empty Frame SOF's] ject

W Usze new Std Reqs & Descriptars Scripts I™ PTR/MTP Session

—Analyziz Tools
™ Emor Repart ™ Bus Utilization
[ Timing Calculatar [~ Mavigator
™ Traffic Summary

— Fontz
Fields: [adia > B| ]
Data: IEourierNew ﬂ B| I

Configuration Mame: |LeEru:|y default

Restare Factory Presets | Save.. | Save Az Default | Load... |

QK I Cancel | Apply |

You can select General, Color/Format/Hiding, and Level Hiding display options. The
following sections describe these display options.
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7.1 General Display Options

You specify the main Trace View information types and settings using General Display
Options (see figure on previous page):

Zoom Level: Zooms out from 100% (default) to 10% or zooms in from 100%
to 200%.

Enable Tips: Pops up text when you position the cursor over a field.

Wrap: Wraps lines of traffic information instead of truncating lines at the right
edge of the display.

Right click cell context menu: By default, clicking the left mouse button on a
field heading displays a context-sensitive pop-up menu providing commands
about the field and clicking the right mouse button pops up a menu with
display options. After selecting this option, clicking the right mouse button on
a field heading displays the context-sensitive pop-up menu and clicking the
left mouse button does nothing.

Hierarchy Lines: Displays lines on the left side of Trace View showing the
hierarchy from Packets to Transactions to Split Transactions to Transfers if
you show higher-level decodes.

Timestamp Position: Aligns the Timestamp field At the beginning (in a
column on the left side of the Trace View), At the end (in a column on the left
side of the Trace View), or Merge with Packet/Transaction/Translation.
Selecting this option allows easier comparison with previous or following
timestamps.

Expand Packet Data Fields by default: Displays packet data fields in
expanded mode. If this option is not selected, packet data fields display in
collapsed mode, and you can expand them manually.

Allow any Toggle value after Bus Reset (Int and Bulk Endpoints):
Depending on the device, after Bus Reset the endpoint toggle state might or
might not be reset. Selecting this option prevents display of a toggle violation
error.

Expand Script-Based Decoded Info by default: Displays decoded transfer
fields in expanded mode. If this option is not selected, decoded transfer fields
display in collapsed mode, and you can expand them manually.

2-stage SOF Hiding: You can display all SOFs, hide all SOFs, or hide empty
SOFs (show only SOFs with endpoint traffic and hide empty frames).
Selecting this option allows you to hide empty SOFs with one click of the Hide
SOF button or hide all SOFs with two clicks of the Hide SOF button.

Use new Std Reqs & Descriptors Scripts: Use dynamically loaded .DEC
files (rather than .REQ and .DSC files) for decoding Class and Vendor
requests or endpoints.
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Analysis Tools

» Error Report: Displays the Errors section of the Traffic Summary
window.

* Timing Calculator: Displays the Timing Calculator window from the
beginning of a packet or marker to the beginning of another packet or
marker, including Total Time unit, Bus Utilization Time and Bandwidth,
and selected Global, Low Speed, Full Speed, High Speed,
Transactions, and Devices.

» Traffic Summary: Displays the Traffic Summary window, showing all
reports, including Packets, Transactions, Transfers, and Errors.

+ Bus Utilization: Displays the Bus Utilization window, including Packet
length, Bus usage, and Bus usage by device.

» Navigator: Displays the Navigation bar, including Pre/Post Triggers,
Errors, and Types of Traffic.

Trace Viewing Level: Displays Packets, Transactions, Split Transactions,
Transfers, Host Wire Adapter Segments, Host Wire Adapter Transfers,
Device Wire Adapter Segments, Device Wire Adapter Transfers,
PTP/MTP Transactions, PTP/MTP Objects, and PTP/MTP Sessions.

Fonts: Sets the font type and bold or italic style for Fields and Data.

Configuration Name: You can name the current set of Display Options
values for use with an .opt file. (The options file can have a different name.)

Restore Factory Presets: Sets all Display Options values to the installed
values.
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7.2 Color/Format/Hiding Display Options

To modify the colors, formats, and hiding options, select the Color/Format/Hiding tab.

Display Options

Gereral Color / Format / Hiding | Leyvel H|d|ng|

X

— Data*
= Format — Bit Order
Fackets £ Hevadecimal :i MSB to LSB
e ) Decimal L5B to M5B
Time ; Binary ~ Hiding
Oither ASL .
- Packet Fields [ Hidden
- Bus Conditions = Colar
Speed
- Frames

7 Pkt Begin/End

Transaction Fields

+- Split Trans Fields

Transfer Fields
On-The-Go

- Generator
+]- PTP Fieldz

Wi colors available for selected item.

Evpand Al | Collapse all |
Restare Factory Presets Save.. | Save Az Default | Load... |
QK I Cancel | Apply |
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Color Display Options

The program uses a default set of colors for each type of data in each group of data. The
colors and color combinations are appropriate for most graphic systems. You can alter

any color.

To specify a color for an information type, in the Color/Format/Hiding tab, select a row
(such as Data) in the Group and Color column and expand it.

Select a data type (such as Data Length) in the Group, then select a color in the Color
section, using Standard or Custom colors. Use a bright color for each important field.

Display Options

General Colar £ Farmat / Hiding | Lewvel H|d|ng|

X

M5B to LSE

CRC

Tirne:

Other

Packet Fields

Bus Conditions

- Speed

- Frames

Pkt Begin/End
+- Transaction Fields
- Split Trans Fields

Transfer Fields
+]- On-The-Ga
+- Generator
7l PTP Fields

Expand All |

D atzs”

- Farmat r— Bit Order

' MSE to LSE
£~ LSB ta M5B

" Heradecimal
" Decimal

" Binary

{1 AT

— Hiding
[~ Hidden

- Calor

Wi colors available for selected item.

Collapse 41 |

Restare Factory Presets

Save... | Save bz Default | Load... |

[ o |

Cancel | Apply |
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To customize colors, use the Custom tab.

r— Colar
Standard Custom |

Calors:

Hue: 234_l Bed: 54_l

Sat: IE ﬁleen.lﬂ
: KR = Blue: |133 _I?

Note: You cannot change the color of an Invalid Data (packet error) field. It is
permanently set to red.

Formats Display Options

For each type of data in each group of data, the program has a default data format.
Examples of number data formats are Bin (binary), Dec (decimal), and Hex
(hexadecimal). Examples of date and time data formats are Hex uFrame, Dec uFrame,
Date & Time, Time, Bit Time, seconds, microseconds, and nanoseconds. An example of
a text data format is ASCII. You can alter some data formats.

To specify a data format for an information type, in the Color/Format/Hiding tab, select a
row (such as Packet Fields) in the Group and Color column and expand it.
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Select a data type (such as PID Types) in the Group:

Group and Caolor | Farmnat | Bit Order | Hidden |
- Other =l

LSE to MSE
W [T A Hex L5B to M5B
- DATAD Hex LSE to MSE
= SETUFP Hex L5B to M5B
- SOF Hex LSE to MSE
- [ - LSB to MSE
- auT Hex LSE to MSE
LSE to MSE
LSE to MSE
LSE to MSE
LSE to MSE
LSE to MSE
LSE to MSE —
LSE to MSE

LSE to MSE

LSE to MSE

LSE to MSE

LSE to MSE

- Token Addressing LI

Select a format in the Format section. The following formats are available for PID Types:

- Packet Figlde+PID Tppess*
—Fammat———— —BitOrder———

{* Hexadecimal + M5B ta LSE

" Decimal " LSB to M5B
£ Binary — Hidirg
£ ASE

[~ Hidden

If available, select Bit Order in the Bit Order section. The options are MSB to LSB or LSB
to MSB.

Hiding Display Options

By default, no data is hidden. You can hide any group of data and any type of data. You
can hide transactions, SOFs; NAKs; High, Full, or Low Speed packets; traffic from one or
both recording channels; and Addresses and Endpoints.

To hide one or more fields, select the Group and Data type in the Group and Color
column, then click the Hidden checkbox in the display or the Hidden checkbox in the
Hidden section of the Format section.
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7.3 Level Hiding Display Options

By default, no data packets, transactions, or bus conditions are hidden. You can hide:
»  Start of Frame packets
* NAK’ed transactions
*  Chirp and SEO Bus conditions
» High, Full, or Low Speed packets
* Channel 0 or Channel 1 packets
Select the Level Hiding tab, then select the data types to hide.

Display Options |

General | Color / Format / Hiding ~ Level Hiding |

Hide Device Traffic

r Popular ltems To Hide Host Addr Endp:

™ Hide Start-0Of-Frame Packets A 000 00
A 000 00
[ Hide Nak'ed Transactions A 002 00

A 002 oo
[™ Hide Chirp Bus Conditions

™ Hide SE0 Bus Conditions

— Hide Packets dccording to Speed

I Hide Low Speed Packsts Hide Packets Bazed on Channel

[ Hide Full Speed Packets o
[ Hide High Speed Packets 1
Restore Factory Presetz Save... | Save bz Default | Load... |

0k I Cancel | Apply |
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7.4 Saving Display Options

You can save a set of Display Options values, make a set the default settings, or use a
saved set of values with the commands at the bottom of the Display Options window:

To save the current Display Options values in an options file for use in future
sessions, click Save. Enter a file name without a file name extension. The
program adds the .opt extension. (The file must have an .opt file name
extension.)

To load a previously saved .opt file, click Load and select a file name.

To save the current Display Options values in the default.opt options file for
use as the default display options, click Save as Default. (Do not delete the
default.opt file.)

To apply the current Display Options values, click Apply. The Display Options
window remains open.

To apply the current Display Options values and close the Display Options
window, click OK.

To cancel unsaved changes to display values and exit the Display Options
window, click Cancel.
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Chapter 8: Decode Requests

8.1 Class

and Vendor Definition Files

LeCroy Analyzers use script files to decode class and vendor requests. The script files
are read when the application is initialized. Once read, the Analyzer then decodes class
and vendor requests as instructed by the files.

.DEC Files represent the new method of decoding. DEC stands for "decoder" and
describes both Class and Vendor requests in a C-like language. The .DEC files are in the
Scripts directory under the application directory. Each .dec file stores an endpoint or
request decode. When the application starts, these files are loaded dynamically.
Subdirectories are supported.

For information about legacy script decoding, see Appendix A “Legacy Script Decoding”
on page 123.

The following .dec files are provided:

USB Decode USB Decoder Name USB-IF Codes
Base Sub Protocol
Class Class ID
Audio Audio 01h
Communications and CDC Control
Direct Line Control Model CCID 02h 01h
Abstract Control Model CCID 02h 02h
Telephone Control Model CCID 02h 03h
Multi-Channel Control Model CCID 02h 04h
CAPI Control Model CCID 02h 05h
Ethernet Networking Control Model CCID 02h 06h
ATM Networking Control Model CCID 02h 07h
Communication Device Subclass/EEM CCID 02h 0Ch
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USB Decode USB Decoder Name USB-IF Codes
Base Sub Protocol
Class Class ID
HID (Human Interface Device) 03h
HUT (HID extension) HID Extension
Monitor (HID extension) HID Extension
Physical Interface HID Extension
(force-feedback extension to HID)
Point of Sale Devices (HID extension) HID Extension
Power (HID extension) HID Extension
Physical HID 05h
Still Imaging Class Still Image/PTP/MTP/PictBridge 06h 01h 01h
Printer Printer 07h 01h xxh
Mass Storage
SCSI/Bulk Protocol Mass Storage SCSI Bulk 08h
UFI(floppy)/CBI Protocol MassStrg Class UFI CBI 08h
Hub support Hub Class 09h
Picture Transfer Protocol (PTP) Still Image/PTP/MTP/PictBridge Extension
[Photographic and Imaging Manu-
facturers Association (PIMA) 15740
and ISO 15740]
Media Transfer Protocol (MTP) Still Image/PTP/MTP/PictBridge Extension
Class Decoding Extension
Video Class decoding 1.1
[currently at 1.0]
Video CONTROL Video OEh 01h 00h
Video STREAMING Video OEh 02h 00h
Video INTERFACE COLLECTION Video OEh 03h 00h
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USB Decode USB Decoder Name USB-IF Codes
Base Sub Protocol
Class Class ID

Pict Bridge Still Image/PTP/MTP/PictBridge

(Camera and Imaging Products)

Wireless Controller

BT HCI EOh 01h 01h
uwB WA Radio Control EOh 01h 02h
Host Wire Adapter Wire Adapter Class EOh 02h 01h
Device Wire Adapter Wire Adapter Class EOh 02h 02h

Miscellaneous

Interface Association Descriptor Standard, EFh 02h 01h
so no decoder method needed

Wire Adapter Multifunction Wire Adapter Class EFh 02h 02h
Peripheral programming interface

Cable Based Association Framework  Standard, EFh 03h 01h
so no decoder method needed

You can create your own .dec file for a Class or Vendor Request. For more information
on the format of these Script Decoder files and the Script Decoding language, read the
Script Decoder Manual.
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8.2 Class/Vendor Decoding Options

You can permanently assign a class or vendor decoding for an address and/or endpoint
or interface in a trace file. Once assigned, the decoding occurs automatically when you
display transactions.

Mapping Request Recipient to Class/Vendor Decoding
To assign a decoding group to a request recipient,
Step 1 Click the Apply Decoding Scripts button on the Toolbar.
OR
Left-click the Control Transfer field to display the USB Device Request menu:

Step 2 Select Map Request Recipients to Class/Vendor Decoding to display the
Request Recipient and Endpoints dialog box:

Request Recipients and Endpoints < == Class;/¥endor Decoding ﬂ

Request Recipients IEndpointsI Frequest FlF'ipesI E ndpiitt FlF'ipesI Fequest D HPipesI E ridpitnt Do FlF'ipesI

Otg Hogt | Addr | Type | Recipient | Claszfendor Decoding |
1} 1 Clazs Interface 0 “wire Adapter Class Requests
1} 1 Clazs RPipe ‘wire Adapter Class Requests

ClazzAdendor Decading Groups :

[~ Keep Acioss Recordings

QK. I Cancel | Apply I Help |

A

The Recipient field shows all Class and Vendor Request Recipients found in the
trace file. The display shows the Host, Address, and Type (Class or Vendor) for
the recipient. On the right are the names of Class/Vendor Decoding groups

currently assigned to recipients. If blank, no decoding is assigned for a recipient.

Step 3 Select a recipient.

Step 4 Display the Class/Vendor Decoding Groups drop-down menu.

Request Recipients and Endpoints <=2 Class/Yendor Decoding x|

Request Recipients IEndpointsI Fequest HPipesI Endpaint HPipesI Request Dwia HPipesI Endpaint Diade, HPipesI

Otg Host | Addr | Type | Recipient | ClazsMendor Decoding |
1] 1 Class Interface 0 HID Class
o 1 Clazz RPipe wire Adapter Class Requests

ClassMvendor Decoding Groups :
HID Class |

--- Mo Decaoding -
| Audio Clags
[ |Communication Clags

Hub Clazs: Requests ok I Cancel Apply Help

Mass Strg Bulk-Only Requests £
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The drop-down menu lists the defined Class/Vendor request decoding groups.
The Class/Vendor Decoding Groups are:
* No Decoding
* Audio Class
*  Communication Class
+ HID Class
+ HUB Class Requests
*  Mass-Strg Bulk-only Requests
* Mass-Strg Class UFI CBI Requests
*  Printer Class
» Standard Requests
+  Stilllmg/PTP/MTP/PictBrg Class Requests
* Video Class Requests
»  Wire Adapter Radio Control Requests
*  Wire Adapter Class Requests
Step 5 Select a decoding group.
OR
Select No Decoding if you do not want any specific decoding.
Step 6 Repeat the previous steps for additional recipients.

Step 7 To retain a mapping from trace to trace DURING an application session, select
the Keep Across Recordings checkbox.

Step 8 Click OK.

Mapping Endpoint to Class/Vendor Decoding
To assign a Class/Vendor Endpoint decoding,
Step 1 Click the Apply Decoding Scripts button on the Toolbar.
OR
Left-click the Bulk/Int Transfer field to display the USB Device Request menu.

Step 2 Select Map Endpoint to Class/Vendor Decoding to display the Request
Recipients and Endpoints dialog box.
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Step 3 Click the Endpoints tab to display the Endpoints dialog box.

Request Recipients and Endpoints < == Class;/¥endor Decoding ﬂ
Request Recipients  Endpaints | Request HPipesI Endpaint HPipesI Request Dwia FiF'ipesI Endpoint Diadd, HPipesI

Otg Host | Addr | Endp | Dir |EIassNendorEndpointDecoding |

0 1 1 auT ire Adapter Data Transfer Out Endp

o [ 1 [ 3 | IN_|

Clage vendor Endpoint Decoding :
Out Endp
[~ Keep Acioss Recordings
QK. I Cancel | Apply I Help |
2

The Endpoint field (Endp) shows all Endpoints found in the trace file. The
displays shows the Host, Address, and Direction for the recipient. On the right
are the names of Class/Vendor Endpoint Decoding groups currently assigned to

endpoints. If blank, no decoding is assigned for a recipient.

Step 4 Select an endpoint.

Step 5 Display the Class/Vendor Endpoint Decoding drop-down menu:

Request Recipients and Endpoints <=2 Class/Yendor Decoding

Fequest Recipients  Endpoints | Request HPipesI Endpoint HPipesI Request Diwa HF'ipesI Endpaint Diadé, HPipesI

X

Otg Host | Addr | Endp | Cir |CIassNendorEndpointDecoding |

0 1 1 OUT  “wire Adapter Data Transfer Out Endp
Diata Transter In End
tif Endp

ClazzAvYendor Endpoint Decoding

“wire Adapter Data Transfer Out Endp j
- Mo Decoding -

| CCID Bulk. Out Meszage
[ |Dizplay DT
tass Strg Bulk-Only SCSI Out Endp

Maszs Strg UFI CBI Bulk Out Endp 0K, I Cancel | Apply I

Help | Y
2

FTP Still Image: Bulk Out

The Class/Vendor Endpoint Decoding options for an OUT endpoint are:

* No Decoding

+ CCID Bulk Out Message

+ Display DATA

* Mass Strg Bulk-Only SCSI Out Endp
* Mass Strg UFI_CBI Bulk Out Endp

»  Stilllmg/PTP/MTP/PictBrg Bulk Out

*  Video Bulk Out

* Video Isoch Out

» Virtual UART

*  Wire Adapter Data Transfer Out Endp
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Step 6

Step 7
Step 8

Step 9

The Class/Vendor Endpoint Decoding options an IN or Interrupt endpoint are:

No Decoding

CCID Bulk In Message
Communication Class Notification
Display DATA

HID In Endp

Hub Class Status Change Endp
Mass Strg Bulk-Only SCSI In Endp
Mass Strg CBI Interrupt Endp
Mass Strg UFI_CBI Bulk In Endp
Mass Strg UFI_CBI Interrupt Endp
Stilllmg/PTP/MTP/PictBrg Bulk In
Stilllmg/PTP/MTP/PictBrg Interrupt
Video Bulk In

Video Interrupt

Video Isoch In

Virtual UART

Wire Adapter Radio Notif Endp
Wire Adapter Data Transfer In Endp
Wire Adapter Notif Endp

Select the type of decoding.

OR

Select No Decoding if you do not want any specific decoding.

Repeat the previous steps for any additional endpoints you would like to map.

To retain a mapping from trace to trace DURING an application session, select
the Keep Across Recordings checkbox.

Click OK.
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Mapping Request RPipe to Class/Vendor Decoding

Before mapping Request RPipes to Class/Vendor Decoding, you must first assign the
following endpoint decoders:

*  Wire Adapter Data Out
*  Wire Adapter Data In
*  Wire Adapter Notif
To assign a decoding group to a Request RPipe:

Step 1 Click the Apply Decoding Scripts button on the Toolbar.
OR
Left-click the Control Transfer field to display the USB Device Request menu.

Step 2 Select Map RPipe to Class/Vendor Decoding to display the Request Recipient
and Endpoints dialog box.

Step 3 Click the Request RPipes tab to display the Request RPipes dialog box:

Request Recipients and Endpoints <=2 Class/Yendor Decoding x|

Hequestﬂecipientsl Endpoints  Feguest RFipes I Endpoint HPipesI Request Diwa HF'ipesI Endpaint Diadé, HPipesI

Otg Hosgt | Hiwdds | RPipe | Type | Recipient | ClaszMendor Decoding |
1} 64 1} Clasz Port Standard Requests
1} 64 1} Clasz FRFPipe Standard Requests

ClazzAvYendor Decoding Groups

Standard Req

[~ Keep Across Recordings

Ok I Cancel | Apply I Help |

The Recipient field shows all Class and Vendor Request recipients found in the
trace file. The RPipe field shows all Class and Vendor Request RPipes found in
the trace file. The displays shows the Otg Host, HWA address, and Type (Class
or Vendor) for the recipient. On the right are the names of Class/Vendor
Decoding groups currently assigned to recipients. If blank, no decoding is
assigned for a recipient.

4

Step 4 Select a recipient.

Step 5 Display the Class/Vendor Decoding Groups drop-down menu. The
Class/Vendor Decoding Groups are the same as for Request Recipients.

Step 6 Select a decoding group.

OR

Select No Decoding if you do not want any specific decoding.
Step 7 Repeat the previous steps for additional recipients.

Step 8 To retain a mapping from trace to trace DURING an application session, select
the Keep Across Recordings checkbox.

Step 9 Click OK.
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Mapping Endpoint RPipe to Class/Vendor Decoding
To assign a Class/Vendor Endpoint RPipes decoding:

Step 1

Step 2

Step 3

Step 4
Step 5

Step 6

Step 7
Step 8

Step 9

Click the Apply Decoding Scripts button on the Toolbar.
OR
Left-click the Bulk/Int Transfer field to display the USB Device Request menu.

Select Map Endpoint RPipe to Class/Vendor Decoding to display the Request
Recipients and Endpoints dialog box.

Click the Endpoint RPipes tab to display the Endpoint RPipes dialog box:

Request Recipients and Endpoints < == Class;/¥endor Decoding ﬂ

Flequestﬂecipientsl Endpointsl Fiequest AFipez  Endpaint RFipes I Fequest D HPipesI E ridpitnt Do FlF'ipesI

OtgHost | Hwi | RPipe | Dir | Clazzfendar Endpaint Decading
dapter Motif Endp

L1} 64 3 OUT  ‘wire Adapter Data Transfer Qut Endp

ClazzAdendar Endpaint Decaoding :
wire Adapter Motif Endp

[~ Keep Acioss Recordings

QK. I Cancel | Apply I Help |

The RPipe field shows all RPipes found in the trace file. The displays shows the
Otg Host, HWA address, and Direction for the recipient. On the right are the
names of Class/Vendor Endpoint Decoding groups currently assigned to
endpoints. If blank, no decoding is assigned for a recipient.

A

Select an endpoint RPipe.

Display the Class/Vendor Endpoint Decoding drop-down menu. The
Class/VVendor Endpoint Decoding options are the same as for Endpoints.

Select the type of decoding.

OR

Select No Decoding if you do not want any specific decoding.

Repeat the previous steps for any additional RPipes you would like to map.

To retain a mapping from trace to trace DURING an application session, select
the Keep Across Recordings checkbox.

Click OK.
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Mapping Request DWA RPipe to Class/Vendor Decoding

Before mapping Request DWA RPipes to Class/Vendor Decoding, you must first assign
the following endpoint decoders:

*  Wire Adapter Data Out
*  Wire Adapter Data In
*  Wire Adapter Notif
To assign a decoding group to a Request RPipe:
Step 1 Click the Apply Decoding Scripts button on the Toolbar.
OR

Left-click the Control Transfer field to display the USB Device Request menu.

Step 2 Select Map DWA RPipe to Class/Vendor Decoding to display the Request
Recipient and Endpoints dialog box.

Step 3 Click the Request DWA RPipes tab to display the Request DWA RPipes dialog
box:

Request Recipients and Endpoints <=2 Class/Yendor Decoding x|

Hequestﬂecipientsl Endpointsl Request HPipesI Endpoint FPipes  Fequest 0wt RFipes IEndpoint Doty HPipesI

Otg Hosgt | Hiwdds |F|F'ipe| Type | Recipient | CIassNendorDecoding|

1] 64 1] Class Port
1} 64 1} Clasz RFipe

[~ Keep Across Recordings

Ok I Cancel | Apply I Help | P

7

The Recipient field shows all Class and Vendor Request recipients found in the
trace file. The RPipe field shows all Class and Vendor Request RPipes found in
the trace file. The displays shows the Otg Host, HWA address, and Type (Class
or Vendor) for the recipient. On the right are the names of Class/Vendor
Decoding groups currently assigned to recipients. If blank, no decoding is
assigned for a recipient.

Step 4 Select a recipient.

Step 5 Display the Class/Vendor Decoding Groups drop-down menu. The
Class/Vendor Decoding Groups are the same as for Request Recipients.

Step 6 Select a decoding group.

OR

Select No Decoding if you do not want any specific decoding.
Step 7 Repeat the previous steps for additional recipients.

Step 8 To retain a mapping from trace to trace DURING an application session, select
the Keep Across Recordings checkbox.
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Step 9

Click OK.

Mapping Endpoint DWA RPipes to Class/Vendor Decoding
To assign a Class/Vendor Endpoint DWA RPipes decoding:

Step 1

Step 2

Step 3

Step 4
Step 5

Step 6

Step 7
Step 8

Step 9

Click the Apply Decoding Scripts button on the Toolbar.
OR

Left-click the Bulk/Int Transfer field to display the USB/WUSB Device Request
menu.

Select Map Endpoint RPipe to Class/Vendor Decoding to display the Request
Recipients and Endpoints dialog box.

Click the Endpoint RPipes tab to display the Endpoint RPipes dialog box:

Request Recipients and Endpoints < == Class;/¥endor Decoding ﬂ

Flequestﬂecipientsl Endpointsl HequestFlF'ipesI EndpointFlF'ipesl Request D' RFipes  Endpoint Diwia HPiDESI

Otg Host | Hiwsay | FPipe | Dir | Clazz/endar Endpaint Decading

0 64 2 W
0 64 3 OUT

[~ Keep Acioss Recordings

QK. I Cancel | Apply I Help | /

A

The RPipe field shows all RPipes found in the trace file. The displays shows the
Otg Host, HWA address, and Direction for the recipient. On the right are the
names of Class/Vendor Endpoint Decoding groups currently assigned to
endpoints. If blank, no decoding is assigned for a recipient.

Select an endpoint DWA RPipe.

Display the Class/Vendor Endpoint Decoding drop-down menu. The
Class/VVendor Endpoint Decoding options are the same as for Endpoints.

Select the type of decoding.

OR

Select No Decoding if you do not want any specific decoding.

Repeat the previous steps for any additional RPipes you would like to map.

To retain a mapping from trace to trace DURING an application session, select
the Keep Across Recordings checkbox.

Click OK.
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8.3 General Options

Commands are transferred on USB using special control transfers called USB Device
Requests. The Analyzer can decode Device Requests as they are defined in the USB
specifications and various Device Class and Vendor specifications.

Each USB Device Request is sent using a Control Transfer. Each Control Transfer starts
with a SETUP transaction.

Decoding USB Device Requests

To decode a USB Device Request:

Step 1 Left-click the Control Transfer field or the SETUP field of the
USB Device Request to display the USB Device Request menu:

USE Device Reguest

Decode Standard Request
ngé Map Request Recipients to Classfvendor Decoding. .

Load mosk recent decoding mapping...

Refresh Decoding For this Trace File

Farmat 4
Color k
Hide:

Note: The menus shown in this section are context-sensitive. You may see slightly
different menus.

Step 2 To refresh decoding, click Refresh Decoding for this Trace File. Use this option
to reanalyze all transactions.

Step 3 To use the previous decoding, click Load most recent decoding mapping.

This option loads the most recent mapping of endpoints/requests to decoding
types that was done on a previous trace. If the endpoints of the new trace are the
same as the last one mapped, the mappings are applied to the current trace. This
saves the user from having to constantly apply the mapping to a new trace every
time the application is restarted and a new trace created.

The ability to retain the mapping from trace to trace DURING an application
session already exists: the Keep Across Recordings button in the endpoint map
dialog. This new feature simplifies the process when the application has been
re-started.

Note: You can also change the format, color, and hidden status of fields, using the
same methods as in Display Options. (See Chapter 6, Display Options.)
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Decoding Standard Requests

To decode a standard request:

Step 1 From the USB Device Request menu, select Decode Standard Request to
display the View Fields for Standard Request text box:

"2 ¥iew Fields for Standard Requests #0 -0 x|
REQUEST SUMMARY -
|Setl11| Data (80 06 00 01 00 00 40 00

Direction Hostto-device
Type Standard
| Recpient | Device
bRequest GET_DESCRIPTOR
wValue DEVICE
| windex | 00000
| wLength | 0x0040
DECODING INFORMATION
. Length Offset Hex .
Field {bits) (bt} Decoded Value Description
bReguest 8 8 GET_DESCRIPTOR 0x06 | bReguest Hexal: 0x0006
whalue 16 16 DEVICE type 0x0100 | Type of Descriptor
windex 18 3z 0x0000 0x0000  index info
DEVICE Descriptor
. Length Offset Hex .
Field {hits) {bits) Decoded Value Description
bLength 8 1) 0x12 0x12 | Descriptor size is 18 bytes
bDescriptorType 8 8 0x01 0x01 | DEYICE Descriptor Type
bedUSE 16 16 0x0200 0x0200 | Device compliant to the USE specificationversion 2.00
bDeviceClass 8 32 0xEF 0xEF | The devicebelongs to theMiscellaneous Device Class
bDeviceSubClass 8 40 0x02 0x02 | The devicebelongs to theCommon Class Subclass
bDeviceProtocol 8 48 0x02 0x02 | The device uses the¥ire Adapter Multifunction Peripheral Protocol
bhaxPacketSizeld 8 a6 040 0x40 | Maximum packet size forendpoint Zero is B4
idvendar 16 b4 Ox1461 Ox1461 | Wendor 1D is 5217 Staccato Cormmunications
idProduct 18 a0 0x0400 0x0400  Product |0 is 1024
bedDevice 16 96 0x0100 0x0100 | The device releasenumber is 1.00
iManufacturer 8 112 0x01 0x01 | The manufacturerstring descriptorindex is 1
iProduct g 120 0x02 0x02 | The productstring descriptorindex is 2
iSerialMumber 8 128 0x00 0x00 | The device doesn't havethe string descriptordescribing the serial number -
bMumConfigurations g 136 0x01 0x01 | The device has 1possible configurations =
uSaveAs..l # Find. | A Layout.. | ﬂEleviousl Hest bl Close I/
%

Step 2 To find a word in the text box, click the Find button. Enter the word in the Find
What field. To use a case-sensitive search, check Match Case. To find only the
exact word, check Match Whole Word Only. You can search Up or Down. To
search, click Find Next.

Step 3 To save the View Fields text box as an HTML file, click the Save As button, enter
a file name in the Save As dialog box, then click Save.

Step 4 To view the previous or next Transfer Control field request of the same request
type, click Previous or Next.

The View Fields for Standard Request dialog box displays field definitions and values of

the Standard Request.
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For field definitions, please refer to the Universal Serial Bus Specification, version 2.0.
The USB specification is available from the USB Implementers Forum (USB-IF) at:

USB Implementers Forum Tel: +1/503.296.9892
1730 SW Skyline Blvd. Fax: +1/503.297.1090
Suite 203 Web: http://www.usb.org/

Portland, OR 97221

Decoding Class Requests

Examples of a class request are Mass-Strg Class UFI CBI Requests,
PTP Still Image Class Requests, Video Class Requests, and Wire Adapter Class
Requests.

To decode a class request:

Step 1 From the USB Device Request menu, select Decode ... Request to display the
View Fields for ... Class Requests text box.

The following figure shows a Wire Adapter Class Requests decoding:

"2 view Fields for Wire Adapter Class Requests #47606 =101 x|
REQUEST SUMMARY M
Setup Data |25 07 00 22 00 00 1C 00
Direction Device-to-host
Type Class
Recipient RPipe
| bRequest|  SET_DESCRIPTOR
‘ wValue | 02200
| wludex | 0x0000
| wLength| 0x001C
=
usaveas.l M Find.. | A Layout. | -JErevluusl Mest bl mj

Decoding Vendor Requests
To decode a vendor request:

* From the USB Device Request menu, select Decode ... Request to display
the View Fields for ... Vendor Requests text box.

An example of a vendor request is USBMobileHS™ Command Set.

Decoding Undefined USB/WUSB Device Requests

A Decoding Request may not belong to any of the defined decoding groups (Standard,
Class, or Vendor).
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Decoding using Endpoint Information

To decode using the endpoint information:

Step 1 Left-click the Bulk/Int Transfer field to display the Bulk/Int Transfer (IN/OUT
transaction with data) menu.

Step 2 Select Decode as ... Endp to open a View Fields for ... Endp text box.
The following figure shows a Wire Adapter Data Transfer Out Endp decoding:

"¥iew Fields for Wire Adapter Data Transfer Out Endp #27 — 1ol x|

Transfer Request : CONTROL

Field Length (hits) | Offset (bits) Decoded Hex Value Description
Length g 0 24 0x18
Reguest Type g8 g 0x80 080 | Transfer Type 0x80 - REQUEST _TYPE_CONTROL
RPipe 16 16 a 00000 | RPipe this transfer is targeted to
Transfer 1D 32 32 | 0x00000000  0Ox00000000 | Host-assigned 1D for this transfer
Transfer Length 32 64 B4 | 000000040 | Arount of data following for an transfer
Last Seg 1 96 1 0x1 | Last Segment
Seq Mum 7 97 1) 0x00 | Segment number
RESERVED 7 104 i} 0x00 | Reserved, should be set to zero
Hfer Dir 1 111 WRITE 0x1 | Control Transfer direction
RESERVED 16 112 a 0x0000 | Resered, should be set to zern

Setup : Data
Length Offset

Field N N Decoded Hex Value Description
(bits) {bits)
DATA_BLOCK B4 128 G bytes | OxB00B000100004000 | Data Block containing 8 bytes e
El
Wsevess.| 3 Frd. | A Layow | ~ Provicus | Mot o | [ Close |/
Z|

Changing the Layout of Decode Requests

In the View ... Fields windows, the Decoding Information and the Descriptor information
blocks (following the Request Summary information) have the following columns:

* Field: such as bRequest, wValue, windex, bLength, bDescriptorType,
wTotalLength

* Length in bits

+ Offset in bits

+ Decoded: hex value typically equal to Hex Value

* Hex Value: hex value typically equal to Decoded

+ Description: short description of field
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To change the layout of decode requests display:

Step 1 Click Layout to display the View ... Fields Dialog Layout dialog box:

Pl view WUSE Xfer Fields Dialog Layo x|

— Colurnnz to show:

Specify here which columnz iniew SOME dialog
tables pou would like o see

¥ Field Check Al
v Length [bits] Urcheck Al
[v Offset [bitz]

v Decoded

v Hex'alue

v Description

[ Show only fields specified for view in collapsed state

[T Use these setiings when Wiew Fields dialog opens

Apply Cancel

Figure 8.1 View WUSB Xfer Fields Dialog Layout Dialog Box

Step 2 To display the available columns of data, use the checkboxes for Length,
Offset, Decoded, Hex Value, and Description.

You can Check All or Uncheck All.

Step 3 To show only the fields of Collapsed mode, check Show only fields specified
for view in collapsed mode.

Step 4 To retain settings for future viewing of Decode Request fields, check Use these
settings when View Fields dialog opens.
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Chapter 9: Reports

The Report menu provides several reports to assist you in analyzing USB traffic recorded
by the Analyzer.

Report  Search  Wiew Window
File: InFormation i

(W) Error Summary

i @ Tirning Calculations
|
I ‘ Traffic Surnrmary

i Bus Utilization
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9.1 File Information

To display a File Information report:

+ Select File Information under Report in the Menu Bar.
OR

« Click | in the Tool Bar to display the File Information screen:

File natne : PTP StilllmageSample. ush

Trace ocourred : Thursday, October 02, 2003 15:11:28
HNumber of packets: 4958%2

Trigger packet number: ()

Comment: Stll Image capture: Thalize, load a picture, ete.

Eecorded with TSR Adwizor 2.0 analyzer, version 2,00 { Buld 235
Analyzer Serial Mumber: 00078
Firmware version: 1.07 { EOM 1.023
BusEngine wersion: 2.00
BusEngine type: 0
The name of the application run by user: TSBAdwnzor. exe
Mumber of markers - 1

Eecording Options
Options MName - Default
Eecording Mode : Snapshot
Buffer Size 63 984 MEBE
Dost-tngger position : 50%
Baze filename & path : C'Program Files\CATCVA dwisor\data ush
Save BExternal Signals : Mo
Auto-Ierge : Mo
Trancate Data : Mo
Trgger/Filter Channel : 1
Eecording Events :

Eecorded on Channel number : 1

Channel 11z Full Speed.
Eecorded on product : Adwnzor (Danghterboard ID: 0z58)

License information for the product, Zerial Mumber 00078, used to record this trace file :
Software maintenance expired on 07/01/2004,

Mo optional icensed features available in thiz wersion of the software.

Save bs.. | Close I

Vi

The File Information report provides information about how the recording was made,
what the buffer settings were, what the trigger options were, and what version of all the
Analyzer hardware was used to make the recording.
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9.2 Error Summary

The Error Summary details all errors analyzed throughout the recording.
* Select Error Summary under Report in the Menu Bar.

OR

+ Click @l in the Tool Bar to display the Error screen below the Trace View:

Traffic Summary - [PTPStillimagesample.ush] i
ERERE N Goeb [0 S cf s - Packet ti
=)~ all reports Twpe /7 | Tokal |
A PRy Packets Bad PID 0
“Trs Transactions Bad CRCS a
. Bad CRC16 ul
i Transfers Bad Packet Length ]
P PTRIMTP Transackion Bad Stuff Bits a
PTR{MTP Cbject Transfer BaghEIOP o
H . Babble Start 1]
#fr PTP{MTP Session Babble End (LOA) 0
"""" (D Bad Frame Length u]
Bad TurnaroundjTimeout u]
Bad Data Toggle i}
Bad FramefuFrame Number i}
Analyzer Internal Error i}
gl Last Byte Incomplete 1]
4 Bad OTG Signal ¥alue n
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9.3 Timing Calculations

Timing Calculator - []

From beginning of:

& b

IF'ac:ket j IU
To beginning of:
IF'ac:ket j |533
Total Time: 3.560045e+008 Inanoseconds 'l
— Bus Utilization
Show Formulas | Time Usage  Bandwidth
v Global 0625 % 0.075 Mbs

v Low Speed

0.000 % 0.000 Mbds

[V Full Speed

0625 % 0.075 Mb/s

[V High Speed

0.000 % 0.000 Mbds

V¥ Transactions

High Speed:;|  0.000 % 0.000 Mbds

[~ with dle Clazsic Speeds:;| 0,347 % 0.042 Mb/s
[ Devices o Idle:
N with Idle:
data Only:
I Acknowledged
| Lalculate i

The Timing Calculator is used to measure timing between any two packets.

Select Reports > Timing Calculations in the Menu or click @l to display
the Timing and Bus Usage Calculator screen:
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9.4 Traffic Summary

Traffic Summary summarizes the numbers and types of packets, transactions etc. that
occurred in the open trace.
To run Traffic Summary, select Report > Traffic Summary or click the button

marked w&|. The program prompts you to specify a range of packets, then displays the
following window:

LeCroy Corporation

Traffic Summary - [PTPStillimagesample.ush] ]
FIEEIEE Goeb [0 S cf s - Packet ti
7 Type / | Tokal I
.Pkt Packets Packets 495992
; Token Transactions 219166
o Split Transactions o
- 10 Data Transfers &0
........ (& Handshake
|—:—|""“Trs Transactions
i (B Handshake
= i‘fr Transfers
o '{'/ Conkrol
...... #iE PTR/MTP Transaction
...... T PTR{MTP Object Transfer
o "
...... Fie PTPIMTP Session E
....... (D Errars z
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9.5 Bus Utilization

The Bus Utilization window displays information on bandwidth use for the three

recording channels.

To open the Bus Utilization window, select Report > Bus Utilization

or click the button marked @ A window opens with graph areas:

Bus Utilization - [PTPStillimageSample.usb]

Packet length 2®
v
w -
. ] l l ‘ . .
; !
o
5 g I
- 30 35 40 45 50 55 &0 Time (s}
< |+
[
Bus usage 2®
o
=S =
z =
i)
21l mem | | | s
30 35 40 45 50 55 &0 Time (s}
< |+
[
Bus usage by device 2®
v
g2 =
z =
i)
) | I __{I=
30 35 40 45 50 55 &0 Time (s}
< |+
[
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Bus Utilization Buttons
The Bus Utilization window has a row of buttons for changing the format of the displayed
data and for exporting data:

The buttons have the following functions:

E = & & |o

B e

Save As - Saves the graphs as a
bitmap file (*.bmp)

Email - Creates an email with a
*.bmp file attachment of the graphs

Print

Full Screen

View Settings - opens a sub-menu
with options for formatting the
display. See “Clicking the View
Settings button opens a menu with
options for formatting the display.”
below.

Horizontal zoom in

Horizontal zoom out

Vertical zoom in

Vertical zoom out

Click and Drag zoom - Click
diagonally to select and zoom in on
part of the graph

Select Range

Sync and Graph areas - If two or
more graphs are displayed, this
button synchronizes the graphs to
one another. Once synchronized, the
positioning slider of one graph
moves the other graphs

Graph Areas - Presents options for
displaying additional graphs of data
lengths, packet lengths, and
percentage of bus utilized.
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View Settings Menu
Clicking the View Settings button @I opens a menu with options for formatting the

display.

[

Crient horizontally

Tile werkically

|

v Show Markers

Shows Plumb Line
Stakus

Grid Lines k

Grid on Top

Fonts & Colors. ..

Orient Horizontally: Changes the orientation of bus usage to horizontal.
After selecting this option, the menu has Orient Vertically.

Tile Vertically: Tiles the two graphs vertically (i.e., side by side). After
selecting this option, the menu has Tile Horizontally.

Show Markers: Places tick marks along the x axis of each graph.
Show Plumb Line
Status: Opens a sub-menu with the following options:

+ Bar: Displays a status bar at bottom of graph.

» Tooltip: Causes a tooltip to appear if you position your mouse pointer
over part of the graph and leave it there for a couple of seconds.

* None: Turns off tooltips and the status bar.
Grid Lines: Opens a sub-menu with the following options:
» Both: Displays both X and Y axis gridlines
+ X Axis: Displays X axis gridlines
* Y Axis: Display Y axis gridlines
* None: Turns off gridlines
Grid on Top: Moves the grid lines above the graph.

98

LeCroy Corporation



USBMobileHS User Manual Chapter 9: Reports

* Fonts and Colors: Opens a dialog box for setting the colors and fonts used in

the graphs:
x
— Fonts
Fitle:
ITimes Mew Roman j |1'| j I?IT
Aoxis:
| aial =ljs =l B 1]
— Colors
Title: B ackground:
T [ —
Az [arnid:
(]9 I Cancel |
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Graph Areas Menu
The Graph Areas menu allows you to view different information in the Bus Utilization
window.

Step 1 Click the ﬁl button to display the Graph Areas menu.

~  Bus Usage
IT Bus used Addr:0 & Bus used Addr:1
Bus used Addr:0
Bus used Addr:1

Step 2 Select the data to appear in the Graph Areas window.

Step 3 To make a new graph, click New.

To change the properties in the Bus Utilizations graph:
Step 1 Inthe Graph Areas menu, select what you want your graph to display, then click

OK.
x
graph Tithe: Appearance:
|New araph IBars [multiple colors) j
Type: [Calar:
I Packet length over time j I _I
r— Filker out
[ Hide Start Of Frame Packets [ Hide Channel
[~ Hide Maked Tranzactions 0
I Hide Chirps ol
. Addr: Endp:
Hide Packets of... oo oo
[~ Low Speed oo oo
I Full Speed
[ High Speed
e | Dtz | (u] 4 I Catcel Apply

Step 2 To make a new graph, click New.
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Chapter 10: Recording Options

Use Recording Options to create and change various features that control the way
information is recorded by the USBMobileHS™ Analyzer.

To open the Recording Options menu:
+ Select Recording Options under Setup on the Menu Bar

OR

TRE
«  Click m*ml on the Tool Bar.
You see the Recording Options window at the General tab:

Recording Options

General |Misc I Eventsl Actionsl

— Recarding type Options

" Manual Trigger

" Event Trigger

¥ Snapshat [ Truncate Data Fields B_I,Jtes:l 1
[~ Beep'when Trigger Ocours

0.500 ME

_J—

— Buffer Sige———————— [~ Trigger Poszition

Mot uzed with snapshot

J_

r— Options Mame
ID efault

(

Trace Filenarne & Path

Change Default Location. . |

Save... |

Save Az Default |

Load... |

Cancel |
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10.1 General Recording Options

The General Recording Options allow you to select or adjust the recording type, the
buffer size, the amount of post-trigger recording, and the trace filename and path.

Recording Type
The Recording Type box presents three options that allow you to set how USBMobileHS
begins and ends a recording.

— Fecording type——
i~ Snhapshat

™ Ewent Trigger

The options are: Snapshot, Manual Trigger, and Event Trigger.

Snapshot

A Snapshot is a fixed-length recording whose size is determined by the Buffer Size box
in the Recording Options dialog.

Recording begins when El is clicked and ends when the buffer is full.

You can stop recording by clicking the @l Stop button.

Manual Trigger
A Manual Trigger is a recording whose trigger point is caused by pressing the trigger
button on the front panel.

Recording begins when you click El on the Tool Bar. Recording continues in a circular
manner within the limits set by the buffer size.

Recording ends when @l is clicked on the Tool Bar or after post-trigger memory has
been filled following depression of the trigger button on the front panel.

Event Trigger
Recording begins when you click EI on the Tool Bar.

Recording continues in a circular manner within the limits set by the buffer size until an
event is detected that meets the Trigger conditions specified in the Triggering Options
and the defined amount of data has been recorded after the Trigger Event.

Options

Truncate Data Fields allows data fields to be truncated during recording to save
Analyzer memory and allow recording of more packets. Enter a minimum data length
value in the Bytes box. USBMobileHS truncates the data to the stated value or slightly
larger.

Note: Truncation of data may cause incorrect transaction or transfer decoding.

Beep When Trigger Occurs causes the computer connected to the USBMobileHS to
beep three times when a trigger condition is first detected.
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Buffer Size

You can adjust the size of the recording buffer from 0.4 megabytes to 64 megabytes.

The Recording type option determines how this buffer is used. Although there are 64
megabytes of physical memory in the Analyzer, the efficiency of the recording is about a
2:1 ratio of physical memory to actual USB traffic. Shorter USB packets yield a slightly
less efficient recording. The non-traffic portion of physical memory is utilized for control
and timing information.

Note: The scale is not linear and affords more granularity in the smaller buffer
sizes.

Trigger Position

You can adjust the amount of recording to be done post-Trigger or select where you want
the Trigger located within the defined buffer. You can adjust the Triggering Position
between 1 and 99% post-Trigger. Trigger Position is available only when Manual
Trigger or Event Trigger is selected as Recording type.

As an example, if the buffer size is set to 16MB, then for the following Trigger Position
settings, the amount of pre- and post-Trigger data is:

*  95% post-triggering: 0.8MB pre-trigger, 15.2MB post-trigger

*  75% post-triggering: 4MB pre-trigger, 12MB post-trigger

*  50% post-triggering: 8MB pre-trigger, 8MB post-trigger

*  25% post-triggering: 12MB pre-trigger, 4MB post-trigger

* 5% post-triggering: 15.2MB pre-trigger, 0.8MB post-trigger

Note: When a Trigger occurs, recording continues until the post-Trigger amount of
the buffer is filled or when Stop is selected.

Options Name
The Options Name is a descriptive label of the current Recording Options settings.
Options Names are associated with files that have a .rec suffix.

The default option name is default. Default preserves the current Recording Options
settings.

The purpose of the Options Name box is to give you a place to preserve different
Recording Options that you use on a recurrent basis. For example, if you use two or three
different Recording Options configurations, you can save these configurations and load
them the next time they are needed.

Because Options Names are descriptive labels and not file names, you can enter in any
text you like into the box. Your labels can be very descriptive such as "Trigger on High
Speed traffic when CRC errors occur."
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Creating a New Recording Options File
To create a new Recording Options name:

Step 1 Enter a comment for the new file in the Options Name field.
Step 2 Click Save.
You see the Save As window.
Step 3 Specify a filename (*.rec)
Step 4 Click Save.

Loading a Recording Options File

To load a Recording Options name:
Step 1 Click Load to display the Open window.
Step 2 From the list of .rec files, select the one that represents your Options Name.

The options settings for that name then display.

Trace File Name & Path

Trace File Name & Path opens a Save As dialog box for saving your trace file. The
default recording file name is data.usb for Low, Full, and High Speed recordings.

¢ Click Trace File Name & Path.

You see a Save As window in which to enter the recording file name *.usb for all
subsequent recordings.
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10.2 Recording Speed

The Misc tab settings allow you to set the speed of traffic and to configure the Analyzer
to record On-The-Go traffic.

Recording Options x|

General  Misc |Events|.t’-‘-.ctions|

—JSE On-The-Go
[ On-TheGo

—Analyzer Trace Speed

 Low = Dl Hale Devices
= Ful I 2DRDs

" High IA—

A e iame

—

B Dey: Hame

[T fssume B is st Host

Save... | Save bz Default | Load... |

Cancel |

* On the Go: Check this if you are tracing an On the Go device. This allows
session request protocol detection.

¢ Dual Role Devices:

+ 2DRD: If both devices are Dual-Role devices, check this box to enable
Host Negotiation Protocol (HNP) detection.

* A Dev Name: Enter a name of your choice to refer to the device that
receives the mini-a plug.

+ B Dev Name: Enter a name for the device that receives the mini-b plug.

+ Assume B is 1st Host: Check this box if your scenario is one where the B
device is acting as host when the trace is started. If the trace incorrectly
identifies the wrong host, you can change it when viewing it by clicking on the
host field of a packet and selecting a switch to the other host ID.
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10.3 Events Recording Options

The Event triggering and filtering options allow you to set specific parameters for each
Event Group. When an Event Group is selected, a field appears that allows you to select
specific conditions within the corresponding Event Group. As details are selected, other
Event Group details may become "grayed out" because of limited hardware resources in
the Analyzer. Information about the resources available is displayed below the Event
Group details. When a detail is grayed out, it is inactive and cannot be selected. If an
Event Group remains inactive, the current version of the application or BusEngine™ does
not support it.

+ Click the Events tab on the Recording Options screen to display the Event
Groups window:

Recording Options x|

General I Misc  Ewents | Actionz I

— Ewent Groups

[|Packet Identifiers ;I
[ 1T oken Patterns

[|Frame Patternz

[ 1Device Request

[ 1Drata Patters

[1Bus Conditions

[1Errars

[ Tranzactions

[ 1Data Lenath

[1Splits

Uncheck Al

Save... | Save bz Default | Load... |

ok | Cancel |
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Packet Identifiers
+ Select Packet Identifiers under Event Groups to display the Packet

Identifiers window:

dac [ eniie
[T oken Patterns
[ |Frame Patterns
[ |Device Regquest
[ |Data Pattern

[ |Buz Conditions
[ |Erors

[ |Transactions

—Ewent Groups——————————

Uncheck Al

out

SOF
SETUP
DATAD
DATAT
DATAZ
MDATA
ACK
A,
STALL
WYET
ERR/FRE
SPUT
PING
0=FF

0xC1 [0 selected)

Select up to 3 PID: for Triggering.

The Packet Identifier (PID) field lists the available packet types. Select up to three packet

types to use as a Recording Trigger.

Token Patterns

+ Select Token Patterns under Event Groups to display the Token Patterns

window:

— Ewent Groups

[ |Packet |dentfiers
W T cken Patterns
[ IFrarne Patterns
D evice Fequest
1D ata Pattern
[1Bus Conditions
[Emors

[ 1Transactions

[ |

Uncheck Al

FID Addr Endp
#1 |ﬂmv :I’ |_ |_
#2 |Any 'l l_ I_
#3 |ﬁny 'l l_ I_

[&ddr and Endp walues are in Hex)

Specify USE token events for Triggering or Filtering.

Specify up to three combinations of Address/Endpoint with any of the token PIDs. They

can be triggered on or filtered in/out.
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Frame Patterns

Select Frame Patterns under Event Groups to display the Frame Patterns
window:

— Event Groups

[ |Facket |denhfiers ;I
[T oken Patterns

[ |Device Regquest
[ |Data Pattern

[1Bus Conditions ™ All Start OF Frame packets
[ |Erors
[C1Tranzactions Frame Mumber [0-7FF] : I
[1Data Length (Hexl
15plits

Uncheck &1l Filker &ll SOF= ar Trigger on & frame number.

Identify frame patterns you want either to filter out of a Trace View or to use as a Trigger.

You can select either All Start of Frame packets (SOF) to be filtered out or specify the
Frame Number of a frame to trigger on.

Device Requests

» Select Device Requests under Event Groups to display the Device
Requests window:

— Ewvent Groups

[ 1Packet Identifiers ;I Pattern Definition

[1Taken Pattems [Hex, msb-»lsb, M5SE-=LSE)
[ IFrame Patterns

— Request #1
[]Bus Conditions Edit |
EE:;Dr:zactions Mumber of Byutes: 0 of 8
[1Data Length  Request #2
[ 15plits
E dit |

Mumber of Byutes: 0 of &

Uncheck &l Specify USE device requests for Triggering.

You can select one or two Device Requests for triggering or filtering.
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Data Pattern

» Select Data Pattern under Event Groups to display the Data Pattern

window:

— Event Groups

["1Packet |dentifiers
[1Token Patterns
[1Frame Patterns
[]Device Request

[]Buz Conditionz
[1Ermars

] Tranzactions
[1Data Length
[]5plits

[

Uncheck &l

Bit-by-bit

MSB - Byte 0
Byte 1
Byte 2
Byte 3
Byte 4
Byte &
Byte 6
Byte 7
Byte 8
Byte 9
Byte 10
Byte 11
Byte 12
Byte 13
Byte 14

LSB - Byte 15

msh Isb
HKHEKRKHKKK

B0 0.9, 9.9.9.9.4
HKHEKKKAKK
L P, 9.9, 0.4.9.4
HHXAXXKXARX
HAXAKKKARK
HKHEEKHKAKK
L P, 9.9, 0.4.9.4
KRRXKXKXARRX
HHXAXXKXARX
B0 0.9, 9.9.9.9.4
HKHEKKKAKK
L P, 9.9, 0.4.9.4
HHXAXXKXARX
HAXAKKKARK
HKAHHH A KK

Cancel |

Fattem Definition
[Hex, msb-»lzh, MSE->LSE]

Edit I

Mumber of Bptez: 0 of 16

Specify data pattemn for Triggering.

=
[
=
=

Enter a Data Pattern to be triggered upon or click Edit to open a pattern editor and enter
data on a bit-by-bit basis.

Step 1 Press the Edit button. to display a Bit-by-Bit window:

=
=
]

=

the appropriate text.
The Mask and Match fields change to reflect your changes.

Step 2 Click your mouse on the bits within each byte that you wish to edit and enter in
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Bus Conditions

» Select Data Pattern under Event Groups to display the Bus Conditions

window:

— Event Groups

["Packet dentifiers ;I Claszic Speed Branches Only
[1Token Patterns [~ USE Reset
S[FJ[:\TEEPHaEELn;st " Single-ended one
[]Data Pattemn [ Suspend

nditions

I:|E I~ Resume
fars

] Tranzactions
[1Data Length
[]5plits

Select one or more types of bus signaling for Triggering.
Unchsck A1 P Anaing 1ar 1ragsnng

Use any combination of the listed errors as a Trigger.

Errors

+ Select Errors under Event Groups to display the Errors window:

— Ewent Groupz

[1Packet [dentifiers ;l [~ Time-out or Turm-araund Yiolatian
[1Token Patterns Turty around time:ISD clocks [1-1023]

[IFrame Patterns [~ Bit Shuf

[ |Buz Conditions

[1Device Request ™ Frame Len ™ Excessive Empty Frame Detection
[IData Paltem  CRC Ermpty Frame Count[127, (1-127)

I Fid I~ Babble Start Violation
[ |Tranzactions

[~ EOP I™ Eabble End Yialation (or LOA)
[~ Short Byte EOFE foset:|59840 clocks (1-65535]

[~ BadData Toggle © I & OUT

el Besetdl™ ﬂddl:|1 Endp:h_

Uncheck A1 Specify Errors for Triggenng, Clocks are 16.66 nSec.

LI [Bulk. or Interrupt Endpoints Only, in Hes)
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Use any combination of the listed errors as a Trigger.

Bit Stuffing, Frame-Length, CRC, Pid, EOP, Short Byte checkboxes -
Select one or more of these errors to set these as the basis for triggering or
filtering. A Short Byte is a condition where EOP begins on a non-byte
boundary.

Time-out Violation - Select this checkbox and then enter in the Turn-around
time in the text box. This value tells the Analyzer how much time should
elapse before triggering/filtering. Clocks are 60 MHz (with a resolution of
16.66 ns).

Excessive Empty Frame Detection - Select this option and enter the empty

frame count in the text box. This value tells the Analyzer how many frames
should elapse before triggering/filtering.

Babble Start Violation - Select this checkbox to trigger or filter whenever the
start of a packet occurs too late in a Frame.

Babble End Violation (or LOA) - Select this to trigger/filter when the end of a
packet occurs too late in a Frame. Enter a value in the EOF offset box from 1
to 65,535 clocks to indicate the size of the offset from start of previous SOF.

Bad Data Toggle - Select this checkbox to trigger or filter whenever a Data0,
Data1, Data2 toggle violation occurs.

Select IN or OUT if you only want triggering/filtering to occur only on IN or
OUT transactions.

Check Incl Reset if you want the first toggle value after a reset to be
considered "good" regardless of the value prior to that reset. If Unchecked,
toggle state is assumed to be preserved through the reset.

Select Addr and/or Endp to select Token Addresses and/or Endpoints.

LeCroy Corporation

111



Chapter 10: Recording Options

USBMobileHS User Manual

Transactions

» Select Transactions under Event Groups to display the Transactions

window:

— Event Groups

[ |Facket |denhfiers
[T oken Patterns
[ |Frame Patterns
[ |Device Regquest
[ |Data Pattern

[ |Buz Conditions

|- |

Uncheck Al

r Tranzachion #1

Data Hex Hex

Token PID Addr  Endp Handshake

fany =[] =]
— Ea |

-

r Tranzaction #2

Token PID' Addr  Endp Handshake

sl -

r Tranzachion #3

Token PID' Addr  Endp Handshake

s -

[Addr and Endp walues are in Hex)

Select Tranzactions for Filtering or Triggering

Use any combination of the listed errors as a Trigger.

Data Length

+ Select Data Length under Event Groups to display the Data Length

window:

— Event Groups

[ |Packet |dentifiers
[T oken Patterns
[ |Frame Patterns
[ |Device Request
[ |D'ata Pattern

[ |Buz Conditions
[1Emors
[Tranzactions

=

Uncheck Al

[rata Length
% Equalto
" Mot Equal to I_
" Less than

" Greater than

Range: 0-2047 Butes, decimal
[Legal USE values are 0-1024)

Trigger on specific data lengths or range.

To trigger on data length, enter a value between 0 and 1024 in the box marked Data

Length.
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Splits

— Event Groups

[ |Facket |denhfiers

[T oken Patterns
[ |Frame Patterns

[ |Device Regquest

[ |Data Pattern
[ |Buz Conditions
[ |Erors

[ |Transactions
(1D ata Length

|- |

Uncheck Al

Select Splits under Event Groups to display the following window.

— Split Type — Endpoint Type—  —Addiesszes [Dec)
i~ Start Hub'l
" Complete Any i
& Don't Care Po'tl
rFS lsach Out— Speed [S]—— rE——7
 Full o
Ay hid " Low 1
% Don't Care % Don't Care

Specity USE Split events for Triggering or Filtering.

To trigger on splits, select a split type, and endpoint type, and an address. You can also
select FS Isoch Out when you select the Isoch endpoint type.
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10.4 Actions Recording Options

The Actions screen serves as a means of setting Triggers, Filters (In or Out), and Counts
for the events selected in the Events window.

Actions Window Layout
The Actions window divides into three sections: left, center, and right.

The left section displays buttons for the events selected in the Events window. Events
buttons tell USBMobileHS what it should look for during a recording. The number of Event
buttons displayed depends on the number of Events selected in the Events window. If no
Events were selected, no Event buttons are displayed.

The right side of the window displays a pair of counters called Count1 and Count2.
Counters provide a way for setting triggers based on a passage of a certain number of
events. When an event is linked to a counter, the counter appears below the event on the
left side of the screen.

The right section displays three Action buttons: Trigger, Filter Out, and Restart. Action
buttons controls USBMobileHS’s response to Event conditions. For example, if an Error
button is linked to a Trigger button, the Action button tells USBMobileHS to trigger when
the error condition occurs.

SOF ® Courtd (55535)
Token1 (=
FIDA[IN)

Count2 ||

Trigger

©
Filter Out

Restart

The lines that join the different buttons indicate the links between Actions and Events.
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10.5 Connecting Events to Actions

To create or edit links between Event buttons, Counters, and Action buttons, you click an
Event button and then click a Counter or Action. By clicking an Event, an arrow connects
the Event button to the cursor. When you click a Counter or Action button, the arrow
becomes anchored to the selected button.

To make an event association:
Step 1 Select one or more Events from the Events window.
Step 2 Open the Actions window.

Step 3 Click the left mouse button on an Event button such as Errors.

The elastic arrow appears.
Step 4 Point your mouse at the desired Action button.
The elastic arrow moves with the mouse pointer.
Step 5 With the pointer over an Actions button, click again the left mouse button again.

The arrow is anchored to the Action button. replaced with a black line connecting
the Event button to the Action button.
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10.6 Connecting Counters to Events

The right side of the Actions window contains two Counter buttons marked Count1 and
Count2.

= ount1 (20}
T-ount? (255)

These counters provide a way of triggering after a number of events have passed, such
as "Trigger after the 20th IN packet."

® Countd (55535)

Trigger

©
Filter Out

Restart

When an event is linked to a counter, the counter appears under that event on the left
side of the Actions window. Counters have blue dots in their top left corner that provide
access to pop-up menus. The menus provide the means of setting the counter value. The
counter can be set between 1 and 65,535.

To connect an event to a counter:

Step 1 Open the Event window and select an Event.
An Event button appears in the Actions window.

Step 2 Open the Actions window.

The window displays an Event button that is connected to the Trigger button on
the right via a line.

Step 3 Click the Event button.
An arrow connects the Event button to the mouse pointer.
Step 4 Click one of the two counters.

The Event automatically connects to the Counter button and then connects to the
Trigger button.
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Step 5 Click the blue dot in top left corner of your selected counter.

® Court1 [7]

- (Bt [115]

™ Changs Counter ¥alue

A pop-up menu opens to allow you to configure the counter.
Step 6 Choose Change Counter Value.
The Input Counter Value dialog box opens.

Step 7 Set the counter to a value, then click OK.

Input Counter ¥V alue E
Input Counter % alue [1..65535); |t25

OF. I Cancel |

The dialog box closes, and the Counter button displays your selection.

Setting Multiple Conditions with Counters

You can create multiple event conditions by linking two counters to two or more events.

Linking Two Events to Two or More Counters - If an Event is linked to Count1 and a
second event is linked to Count2, it creates an OR statement. This statement reads
"Trigger when Count1 OR Count2 has reached their specified values."

This example reads "Trigger when Count1 has counted nine Out packets or Count2 has
counted nine In packets."

[F__FiDa[ouT

®  Courtt(9)

=]
=]

FIDZ[IN)

Courtz [3]

Trigger

@
Filter Out

Restart
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10.7 Using Action Buttons

The right section of the Actions window displays three Action buttons labeled Trigger,

Filter Out/In, and Restart.

Trigger

=
Filter Out

Restart

Trigger

The Trigger button enables event triggering.

Restart

Restart causes counters to restart counting when a certain event occurs. When Restart
is used, the screen has at least two links: one between an Event and the Restart button,

and a second between an Event, Counter and an Action button.

The screenshot below gives an example. The screen below reads "Look for IN and Out
packets. When 10 OUT packets, trigger. However, if an IN packet occurs during the

count, restart the count.”

USBMobileHS User Manual

F  PiDijouT)
=

Courtd (10]

©  PIDZ(IN)

Trigger

©
Filter Out

Restart
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Filter Out/In

The Filter In/Out button causes events to be filtered in or out of the recording. Filter
Out/In toggles between:

» Filter In records ONLY those packets related to the specified event.
»  Filter Out records all packets EXCEPT those related to the specified event.

Note: Only events from the Token, Frame Event, Device Request, and Transaction
Groups can be used to filter a recording.

To filter in or out Token, Frame Event, Device Request, and/or Transaction Group events
from a recording,

Step 1 Click the blue dot on Filter Out. (Note: the button may say Filter In depending
on the last action specified.)

You see the Filter Polarity menu:

@
I v Filter Ot
Filter In

Step 2 Select Filter In.

The button changes to read Filter In.

10.8 Saving Recording Options

To complete your Recording Options settings, use the features at the bottom of the
Recording Options screen. These features remain the same no matter which of the
three Recording Options screens you are working in.

+ Click Save to save the currently specified Recording Options for use in future
recording sessions. Any file name can be specified, though use of the .rec is
recommended; if no extension is specified, .rec is added by default.

* Click Load to load a previously saved *.rec file, thus restoring a previous set
of Recording Options.

+ The Save as Default function is equivalent to the Save function, specifying
the file name default.rec. Whenever you start up the Analyzer, it
automatically loads the default.rec file if one exists.

» Click OK to apply any changes and close this dialog box.

+ Click Cancel to cancel any immediate changes you have made and exit the
Recording Options menu.
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10.9 Recording Bus Data

Note: If you have inserted any event triggers, be sure to select Event Trigger
under the General tab in the Recording Options dialog box.
To start recording USB traffic after the appropriate Recording Options have been set:
Step 1 Select Start under Record on the Menu Bar.
OR
Click El on the Tool Bar.
Your recording session can continue until it has finished naturally,

or you may need to stop manually by clicking @l on the Tool Bar, depending on how
you set the Recording Options.

To manually stop recording:
Step 1 Select Stop under Record on the Menu Bar.
OR
Click @ on the Tool Bar.
Click @ again during the uploading to upload only a portion of the recorded memory.

Note: The manual Stop Recording feature is primarily of use when recording
low-speed traffic, which can take a long time to fill the recording buffer.

When the recording session is finished, the bus traffic is saved to the hard drive as a file
named data.usb or whatever name you assign as the default filename.

To save a current recording for future reference:
Step 1 Select Save As under File on the Menu Bar.
OR
Click Ell on the Tool Bar.
You see the standard Save As screen.

Step 2 Give the recording a unique name and save it to the appropriate directory.
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Chapter 11: Updates

From time to time as modifications are made to the USBMobileHS™ Hi-Speed USB
Analyzer, it is necessary to update the Analyzer for optimal performance.

11.1 Software, Driver, and BusEngine Revisions

The Readme.txt file on the first installation disk and in the installed directory gives
last-minute updates about the current release.

Once the Analyzer has completed the self diagnostics and is connected to the PC, you
can check the latest revision of the software and BusEngine™ by selecting About
USBMobileHS... from the Help menu.

About USBMobileHs x|

LeCroy USBMobile™HS
USBE Protocol Analyzer

Software Wersion 2,30, Build 3531
Driver Version not available
BusEngine Yersion not available
Serial Mumber naot available

2003-2005 LeCroy Corporation
OK |

About USBMobileHS details revisions of the following software and hardware:
USBMobileHS Software Version
+ USBMobileHS Driver Version
+ BusEngine Version
*  Unit Serial Number

Note: When contacting LeCroy for technical support, please have available all the
revisions reported in the About USB USBMobileHS window.
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11.2 Software Updates

When a new software release is available, it is posted on the Support page of the LeCroy
website at www.lecroy.com/support.html.

To update the software:

Step 1

Step 2

Step 3
Step 4
Step 5
Step 6
Step 7
Step 8
Step 9

In the About USBMobileHS screen, verify which version of USBMobileHS
Software you are currently running.

Find the latest released software version on the LeCroy website under Support.

If you are running the latest version of the software, no further action is
needed.

If you are not running the latest version, continue to Step 3.
Download the Zip files from the website.

Unzip the files into your choice of directory.

Click Start, then Run, and browse to where you unzipped the files.
Select the program named Setup and click Open.

Click OK to run the Setup and begin the installation.

Follow the on-screen instructions to complete the installation.

Read the Readme file for important information on changes in the release.

11.3 BusEngine and Driver Updates

The Bus Engine and driver updates are done automatically during software installation.
No user interaction is necessary or possible.
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Appendix A: Legacy Script Decoding

Earlier LeCroy USB Analyzers used .REQ and .DSC script files to decode class and
vendor requests.

+ .REQ stands for Requests.

» .DSC stands for Descriptors.
This method uses fixed definitional structures.
For legacy script decoding, LeCroy provides .req files for the following requests and
classes:

+ Standard Requests (standard.req)

* Hub Class (hub.req)

+ HID Class (hid.req)

*  Printer Class (printer.req)

«  Communications Class (communication.req)

* Audio Class (audio.req)

*  Bluetooth USB HCI commands and events (bluetooth.req)

*  Vendor Request definition file (vendor.req)

Note: .req files are no longer used in LeCroy USB Analyzers.
In addition, .req files are not compatible with the UWBTracer
application.
The new script decoding for LeCroy USB Analyzers uses
Script Decoder version .dec files.
.dec files are compatible with the UWBTracer application.
It is highly recommended that you use the new Script Decoder
mechanism.
For information about .dec files and the new script decoding, see
“Class and Vendor Definition Files” on page 75.

If you must add your own .req file for a Class or Vendor Request, do the following:

Step 1 Use the Notepad application to create and edit your own Request Definition file
(for example, my_vendor_commands.req).

Note: To learn to write such a file, review the Request (.req) files provided by
LeCroy.

Step 2 Add the name of your Request file to the request.lIst file.
Step 3 Click Setup. The decoding menu in the Class/Vendor List appears.
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How to Contact LeCroy

Type of Service

Contact

Call for technical support...

US and Canada:

1 (800) 909-2282

Worldwide: 1 (408) 727-6600
Fax your questions... Worldwide: 1 (408) 727-6622
Write a letter... LeCroy

Customer Support

3385 Scott Blvd.

Santa Clara, CA 95054

Send e-mail...

support@catc.com

Visit LeCroy’s web site... http://www.lecroy.com/

Limited Hardware Warranty

So long as you or your authorized representative ("you" or "your"),
fully complete and return the registration card provided with the

applicable hardware product or peripheral hardware products roy
(each a "Product") within fifteen days of the date of receipt from

LeCroy or one of its authorized representatives, LeCroy warrants

that the Product will be free from defects in materials and workmanship for a period of three years
(the "Warranty Period"). You may also complete your registration form via the internet by visiting
http://www.catc.com/support/register/. The Warranty Period commences on the earlier of the date

of delivery by LeCroy of a Product to a common carrier for shipment to you or to LeCroy's
authorized representative from whom you purchase the Product.

What this Warranty Does Not Cover

This warranty does not cover damage due to external causes including accident, damage during
shipment after delivery to a common carrier by LeCroy, abuse, misuse, problems with electrical
power, including power surges and outages, servicing not authorized by LeCroy, usage or
operation not in accordance with Product instructions, failure to perform required preventive
maintenance, software related problems (whether or not provided by LeCroy), problems caused by
use of accessories, parts or components not supplied by LeCroy, Products that have been modified
or altered by someone other than LeCroy, Products with missing or altered service tags or serial
numbers, and Products for which LeCroy has not received payment in full.

Coverage During Warranty Period

During the Warranty Period, LeCroy or its authorized representatives will repair or replace
Products, at LeCroy's sole discretion, covered under this limited warranty that are returned directly
to LeCroy's facility or through LeCroy's authorized representatives.
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How to Obtain Warranty Service

To request warranty service, you must complete and return the registration card or register via the
internet within the fifteen day period described above and report your covered warranty claim by
contacting LeCroy Technical Support or its authorized representative.

You can reach LeCroy Technical Support at 800-909-7112 or via email at support@catc.com. You
may also refer to the LeCroy website at http://www.lecroy.com for more information on how to
contact an authorized representative in your region. If warranty service is required, LeCroy or its
authorized representative will issue a Return Material Authorization Number. You must ship the
Product back to LeCroy or its authorized representative, in its original or equivalent packaging,
prepay shipping charges, and insure the shipment or accept the risk of loss or damage during
shipment. LeCroy must receive the Product prior to expiration of the Warranty Period for the
repair(s) to be covered. LeCroy or its authorized representative will thereafter ship the repaired or
replacement Product to you freight prepaid by LeCroy if you are located in the continental United
States. Shipments made outside the continental United States will be sent freight collect.

Please remove any peripheral accessories or parts before you ship the Product. LeCroy does not
accept liability for lost or damaged peripheral accessories, data or software.

LeCroy owns all parts removed from Products it repairs. LeCroy may use new and/or reconditioned
parts, at its sole discretion, made by various manufacturers in performing warranty repairs. If
LeCroy repairs or replaces a Product, the Warranty Period for the Product is not extended.

If LeCroy evaluates and determines there is "no trouble found" in any Product returned or that the
returned Product is not eligible for warranty coverage, LeCroy will inform you of its determination.
If you thereafter request LeCroy to repair the Product, such labor and service shall be performed
under the terms and conditions of LeCroy's then current repair policy. If you chose not to have the
Product repaired by LeCroy, you agree to pay LeCroy for the cost to return the Product to you and
that LeCroy may require payment in advance of shipment.
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General Provisions

THIS LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS. YOU MAY HAVE
ADDITIONAL RIGHTS THAT VARY BY JURISDICTION. LECROY'S RESPONSIBILITY FOR
DEFECTS IN MATERIALS AND WORKMANSHIP IS LIMITED TO REPAIR AND REPLACEMENT
AS SET FORTH IN THIS LIMITED WARRANTY STATEMENT. EXCEPT AS EXPRESSLY STATED
IN THIS WARRANTY STATEMENT, LECROY DISCLAIMS ALL EXPRESS AND IMPLIED
WARRANTIES FOR ANY PRODUCT INCLUDING, BUT NOT LIMITED TO, ANY IMPLIED
WARRANTIES OF AND CONDITIONS OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE, AND ANY WARRANTIES THAT MAY ARISE FROM ANY COURSE OF
DEALING, COURSE OF PERFORMANCE OR TRADE USAGE. SOME JURISDICTIONS MAY
NOT ALLOW LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS, SO THE
PRECEDING LIMITATION MAY NOT APPLY TO YOU.

LECROY DOES NOT ACCEPT LIABILITY BEYOND THE REMEDIES SET FORTH IN THIS
LIMITED WARRANTY STATEMENT OR FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES
INCLUDING, WITHOUT LIMITATION, ANY LIABILITY FOR THIRD PARTY CLAIMS AGAINST
YOU FOR DAMAGES, PRODUCTS NOT BEING AVAILABLE FOR USE, ORFOR LOST DATA OR
SOFTWARE. LECROY'S LIABILITY TO YOU MAY NOT EXCEED THE AMOUNT YOU PAID FOR
THE PRODUCT THAT IS THE SUBJECT OF A CLAIM. SOME JURISDICTIONS DO NOT ALLOW
THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE
PRECEDING EXCLUSION OR LIMITATION MAY NOT APPLY TO YOU.

The limited warranty on a Product may be transferred for the remaining term if the then current
owner transfers ownership of the Product and notifies LeCroy of the transfer. You may notify LeCroy
of the transfer by writing to Technical Support at LeCroy, 3385 Scott Blvd., Santa Clara, CA 95054
USA or by email at: support@catc.com. Please include the transferring owner's name and address,
the name and address of the new owner, the date of transfer, and the Product serial number.
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